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Section 1 Preliminaries

It is assumed that the users of Optika™ Vision Pro and the readers of
this document have a working knowledge of microscope, digital
camera and Microsoft Windows. Optika™ Vision Pro may be used for
both compound and stereo microscopes. It also contains a few
functions specifically designed for fluorescent imaging. Optika™
Vision Pro conforms to the Microsoft Windows User Interface
Guideline and so is similar to other programs in opening files and
mouse operations.

This section lays a background for image analysis with Optika™
Vision Pro.
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Image

Color Models

Digital images record colors by numbers. Color models are particular
means to represent color by numbers. Optika™ Vision Pro uses a
number of color models for image acquisition, display, processing
and printing. In most cases the underlying color model is transparent
to users. Where they are explicit, an understanding of RGB and HSI
models suffices for the purpose of working with Optika™ Vision Pro.

RGB

A large portion of the visible spectrum can be represented by mixing
three basic components of colored light in various proportions and
intensities. These components are known as primary colors: red,
green and blue (RGB). Computer screens use RGB model to display
graphics and images. Most 8-bit image processing programs,
including Optika™ Vision Pro, employ a triple of integers in the range
[0,255] to represent a color being described by RGB model.

HSI

Human beings understand colors by their three fundamental
characteristics: hue, saturation and intensity (HSI). Hue is the
wavelength or frequency of light reflected from or transmitted
through an object. Most often hue is identified by the name of the
color such as orange or purple. Saturation is the strength or purity of
the color and represents the amount of gray in proportion to the hue.
Intensity stands for the relative lightness or darkness of the color. It is
the energy contained in the color.

As in the case of RGB model, Optika™ Vision Pro uses a triple of
integers of the range [0,255] to represent a color based on HSI model.
However, a particular camera supported by Optika™ Vision Pro may
implement a camera-specific range of values for hue, saturation or
intensity and may not use integers to represent the value. For example,
some cameras allow the adjustment of saturation in the range [0, 1].
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In this situation, it is understood that the real number in the range [0,
1] will be scaled to [0, 255] and added to the saturation component of
pixels in each frame of the video from that camera.

Luminance is sometimes used in place of intensity in describing a
color by HSI model. In camera terminology gain has the greatest
similarity to intensity. Whenever gain is involved, it is multiplicative
instead of additive as in the processing of a still image.

Grayscale and Indexed Color

When a digital image is not concerned with any chromatic meaning,
Grayscale model is used to represent colors. In this case, a single
integer in the range [0, 255] is used to describe the energy content of
a color, corresponding to the intensity channel of HSI model.

The other color model that uses a single number to describe the color
is the Indexed Color which is based on a palette of 256 colors. Optika
™Vision Pro does not attempt to interpret the color in an image of
indexed color. Whenever it reads a file of indexed color image, it
converts the image to grayscale by simply mapping the indices to the
intensities of a grayscale image.

Color Components and Channels

In RGB model, each of the red, blue or green values is referred to as a
component or channel of the color. Color component and color
channel are used interchangeably in this document. The same is true
for HSI model and Grayscale model. A color described by the HSI
model has three components or channels, namely the hue channel, the
saturation channel and the intensity or luminance channel. A color
described by Grayscale model has only one channel, namely the
intensity channel.

The triple used by RGB and HSI models, and the single number used
by Grayscale model, are called color value.

Color Model Conversions

RGB and HSI are equivalent means to describe colors. The main
reason to use multiple color models is to facilitate the understanding
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of image processing of Optika™ Vision Pro. The internal conversion
between the two models is handled implicitly and needs no user input.

RGB and HSI may also be used to represent a monochrome image as
Grayscale model does. In this situation, the three channels of RGB
are set equal, and the hue and saturation channels of HSI are set to
zero.

Raster Images and Vector Graphics

The components that make up the scene on a computer screen fall
into two main categories: raster images and vector graphics.

Raster images use a grid of small squares, known as pixels, to
represent pictures. Each pixel in a raster image has a specific location
and color value assigned to it. When working with raster images,
groups of pixels rather than objects or shapes are being edited.
Because they can represent subtle gradations of shades and color,
raster images are the most common electronic medium for
continuous-tone pictures such as photomicrographs.

The terms raster image and pixel array are used interchangeably in
this document. In fact, a raster image may also be described as a
matrix of points. The distance between neighboring points on a row is
referred to as the horizontal sampling interval. The distance between
neighboring points on a column is referred to as the vertical sampling
interval. Sampling interval multiplied by the number of columns and
rows is exactly the size of the field of view over which the image has
been captured.

Vector graphics consists of lines and curves defined by mathematical
objects called vectors which describe pictures according to their
geometric characteristics. The lines or curves of an object can be
painted with a specific color. The interior of the shape enclosed by
these lines and curves may also be painted with a specific color.
Vector graphics can have only a limited number of colors and cannot
represent natural scenes. They are mainly useful in annotating raster
images.

Raster images are resolution-dependent, that is, they represent a fixed
number of pixels and can appear jagged and lose detail if they are
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scaled on-screen, or if they are printed at a higher resolution than they
were created for. On the other hand, vector graphics are resolution-
independent, that is, they are defined by analytical formulas and so
can be scaled arbitrarily to appear crisp and sharp on any output
device at any resolution.

Optika™ Vision Pro works with both raster images and vector
graphics. The images grabbed from cameras are raster images. The
annotation objects created with Optika™ Vision Pro are vector
graphics. In a broad sense, both raster images and vector graphics are
considered digital images or digital pictures. Vector graphics are
always converted to raster images for purpose of display, a process
known as digitization. Optika™ Vision Pro can also burn vector
graphics into raster images. This is the same as digitization but is
irreversible.

The Layers

For any image processing program that is more sophisticated than a
simplest viewer, there has to be some extra information attached to
pixels. For example, sampling intervals and magnification settings
are also recorded in an image of Optika™ Vision Pro. In fact, even the
pixels have to be organized into layers. Each layer is either a raster
image or a vector graphics object. Layers may be combined in
various ways to produce specific presentations of an image of Optika
™Vision Pro. The presentation itself is a simple raster image.

An image of Optika™ Vision Pro has three layers. The bottommaost
layer is the pixel array, also called the pictorial layer. The topmost
layer is the overlay, where the graphics generated by measurement
operations and micrometer are placed. In between is the mask layer.
This layer is used by advanced editions of Optika™ Vision Pro to hold
segmentation results.

In displaying an image, its pictorial layer is drawn first. The layers
above pictorial layer are drawn later and may obscure the pictorial
layer.

When Optika™ Vision Pro is running, there can be temporary layers
hosting annotation objects. Each annotation object occupies a
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temporary layer by itself. The temporary layers are above any other
types of layers. Annotation objects may be burned into the image,
where the pictorial layer is modified according to the vector graphics
of the temporary layers. Unburned annotation objects, i.e. temporary
layers, are discarded when the image is closed.

The Active Image

With Optika™ Vision Pro, many images can be open simultaneously.
However, only one of them may receive input focus. This image is
referred to as the active image. In this document, the active image,
the current image, or sometimes the active image window, are used
interchangeably.

The active image window can be told easily from the other image
windows. Its title is being appended to the title of the main window.
Its caption is being highlighted. When tabs are enabled for image
windows, the color of the tab of the active image is the same as the
color of the inner frame of the main window, as shown below in
yellow. The first example illustrates the active image window in
normal state. The second example illustrates the active image
window in maximized state.

The Empty Image Window

Optika™ Vision Pro employs an empty image window to display live
images from the camera. The live image may pan and scroll in the
same way as a still image, i.e. the hand tool is also available for live
image.
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Workspace

Besides image windows, many other windows or user interface
elements reside within the main window of Optika™ Vision Pro.
These include menu, toolbars, status bar and auxiliary windows
providing additional information about the images or control of the
camera.

Menu

The menu can be either docked or floating. Double-click its grip or
caption bar to toggle between the two states. When the menu is
docked, it can be docked to any of the four sides of the main window.
Drag the grip or caption of the menu to adjust its position or to dock
it to a particular side of the main window. The grip of the menu is the
dot matrix at the left or top of the menu in docked state.

Toolbar

Optika™ Vision Pro has four toolbars. Each toolbar can be either
shown or hidden. When a toolbar is shown, it can be either docked or
floating. Double-click its grip or caption to toggle between the two
states. When a toolbar is docked, it can be docked to any of the four
sides of the main window. Drag the grip or caption of a toolbar to
adjust its position or to dock it to a particular side of the main
window. The grip of a toolbar is the dot matrix at the left or top of the
toolbar in docked state.

Status Bar

The status bar is located at the bottom of the main window.
Depending on whether a still image or the video is being displayed in
the active image window, the status bar gives different information.

The status bar is divided into thirteen panes from left to right. What
they will display is listed below.
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Pane Index

Still Image

Live Image

1 Command prompt Command Prompt
(Leftmost)

2 Mouse position in horizontal | The horizontal offset
direction, in pixels, relative to | of the region of
the top left corner of the interest on the camera.
active image.

3 Mouse position in vertical The vertical offset of
direction, in pixels, relative to | the region of interest
the top left corner of the on the camera.
active image.

4 The red component of the The width of live
pixel at the mouse position. image, in pixels.

5 The green component of the The height of live
pixel at the mouse position. image, in pixels.

6 The blue component of the The number of
pixel at the mouse position. columns of the pixel

array of the camera.

7 The hue component of the The number of rows
pixel at the mouse position. of the pixel array of

the camera.

8 The saturation component of | The current gain of the
the pixel at the mouse camera.
position.

9 The intensity component of The current exposure
the pixel at the mouse time, in milliseconds,
position. of the camera.

10 The phase index of the pixel | The current frame rate
at the mouse position. of the camera.

11 The magnification of the The magnification
active image. setting of the system

micrometer.

12 The width of the active The width of the
image, in microns. whole field of view, in

microns.

13 The height of the active The height of the

(Rightmost)

image, in microns.

whole field of view, in
microns.

10
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Auxiliary Window

Optika™ Vision Pro has five auxiliary windows: Control Panel, Help
Desk, Database, Measurement and Histogram. Each of these auxiliary
windows can be either visible or hidden. When an auxiliary window,
except Control Panel, is shown, it can be either docked or floating.
Double-click the grip or caption of an auxiliary window to toggle
between the two states. When an auxiliary window is docked, it can
be docked to any of the four sides of the main window. Drag its grip
or caption to adjust the position of an auxiliary window or to dock it
to a particular side of the main window. The grip of an auxiliary
window is the dot matrix at the left or top of the caption bar of the
window in docked state. All the auxiliary windows can be resized in
the same way as an ordinary window.

Control Panel

Control Panel is where camera control and image acquisition
commands are issued, image capture options are set and acquired
images are cached. Two panes, Imaging Control and Field Group,
comprise Control Panel. Imaging Control Panel is further divided into
seven sub-panes for specific aspects of the imaging process. Sub-
panes are collapsible. To collapse a sub-pane, click the arrows at its
top right corner. To expand a collapsed sub-pane, click again the
arrows at this to right corner. The arrows at the top left corner of a
sub-pane point upward in expanded state and downward in collapsed
state. Control Panel also maintains a history of the panes shown.

11
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Help Desk

Help Desk ]
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Help Desk provides context sensitive information for commands that
involves extended mouse actions.
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2 Tissue 2006-04-22 18:01:25 Jack |The haze illustrates spherical aberration, It cannot be
3 Bone | Z006-04-ZZ 16:35:42  Jack Radiograph processed as pho
£ 2

The database provides full control over the built-in database. Some
commands may only be available from this auxiliary window. For
example, click a column header to sort the list. This command is not
accessible from menu.

13
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Measurement

Measurement !_I
Command | Parameter | Walue ||
Zaliper Distance 105,48
frea Perimeter  Area 593,50
Area Perimeter Perimeter 339,68
Area Perimeter | Area 10532.00
Area Perimeter | Perimeter (511,42 b

This auxiliary window is used to hold measurement result. A row or
an entry is also referred to as an entry. As illustrated above, an entry
consists of three cells, namely the command that generates the entry,
the parameter that is being measured, and the measurement result. A
measurement command may generate more than one entry because
two types of parameters may be measured with a single command.
Entries may be selected and dragged to an external program for
further processing.

Histogram

Histogram

.S LT
lUl_ L I_l_.-'

14

www.optikamicroscopes.com



A histogram is a graphic representation of the number of pixels at
each brightness level in an image. Optika Vision Pro plots histograms
for all three channels of the active image based on RGB color model.
In the black square box, the x axis represents the color value from
darkest (0) at the far left to brightest (255) at the far right; the y axis
represents the frequency, i.e. the total number of pixels with that
value; the origin of the histogram is the bottom left corner of the
black box. Note that histograms of red, green and blue channels are
shown in the same coordination system as red, green and blue bars
and so they may overlap. The following table helps to tell the
overlapping range of the histograms.

Red and Green

- Red and Blue

Green and Blue

Red and Green and Blue

The histogram can be shown for both still and live images. For a still
image, its histogram is updated whenever the image itself is being
modified in any way, including the way it is being displayed. For a
live image, its histogram is updated in every three seconds. In both
cases, the histogram is only for the part of the active image that is
visible on computer screen.

Superimposed on the histogram is a look-up table (LUT) which may
be applied to incoming images from the camera. The LUT is
specified by two controlling points, namely the left point (x1, y1) and
the right point (x2, y2). The two controlling points, together with two
end points (0, 0) and (1, 1), defines three connected line segments
that map the dynamic range of the camera to 8 bits. LUT may be
turned on or off, reset, or specified by directly entering coordinates of
controlling points, using the toolbar button at the top of the histogram
window.

15
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Section 2 Menu Commands

Most commands are accessible from menu. Some of the more
frequently invoked commands also have toolbar buttons and/or
shortcut key combinations associated with them. Those commands
that are not accessible from menu are described in “Section 3 Other
Commands.”

Relating a toolbar button to a menu item

The toolbar button is also drawn to the left of the corresponding
menu item, in addition to appearing separately on a toolbar.

Relating a shortcut key combination to a menu item

A short textual description of the shortcut key combination is shown
to the right of the corresponding menu item.

Optika™ Vision Pro has 7 major menus:

Document Menu

Main Frame Menu

OLE Container Menu

OLE Server Menu

Field Group Context Menu

Image Window Tab Context Menu

Toolbar and Auxiliary Window Context Menu

NogakownpE

Most work will be carried out by commands in Document Menu,
which is the default menu when Optika™ Vision Pro starts up.

Main Frame Menu will replace Document Menu whenever there is no
image window in the main window. The commands contained in this
menu are mainly useful in creating a new image window, by New for
Video Preview or Open, or to exit from Optika™ Vision Pro, by Exit.
Main Frame Menu will not appear when there is an image window in
the main window.

OLE Container Menu will be called up only in the image annotation
process when an external object is inserted and the server of this

16
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object is activated. In this situation, OLE Container Menu will merge
with the object’s server menu.

OLE Server Menu will be invoked when a native image object of
Optika™ Vision Pro is embedded into a document of another
container program and is being edited. Optika™ Vision Pro will load
the embedded image into its own image window. When this image is
the active image, OLE Server Menu will be used.

Field Group Context Menu may be brought up by right-click
anywhere within Field Group.

Image Window Tab Context Menu may be brought up by right-click
anywhere within tab area of image windows.

Toolbar and Auxiliary Window Context Menu may be brought up by
right-click any area of the main window that is not occupied by any
menus, toolbars, auxiliary windows or image windows.

In the following only the Document Menu is described. The other
menus often duplicate part of the Document Menu to provide a level
of convenience. Where they are unique, they are usually simple
commands that explain themselves.

17
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The File Menu

File menu commands are used to open, save, print and capture
images. Some of those camera manipulation commands also reside
here.

New for Video Preview

Use the New for Video Preview command to create an empty image
window to display live images from the camera.

The caption of the created window is intended to be the model or
name of the camera presently attached to the computer. If no camera
is connected or none of the connected cameras is working properly,
the caption of the created window is “Video”.

For those cameras supporting the notion of serial number, a dash
followed by the serial number may be appended to the window
caption.

Open

Use the Open command to load existing image files.

Multiple images of various formats in a folder can be simultaneously
opened. Besides the native image format (*.sif), numerous commonly
used image formats are supported. Files of unsupported formats will
be filtered out and will not be visible in the dialog box.

Equivalent Commands

e Drag one or more selected files in Windows Explorer and
drop them in the main window of Optika™ Vision Pro.

e Double-click a file of native image format (*.sif) in Windows
Explorer.

The recognizable image file formats are listed below.

18
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Format File Remark
Extension

Native SIF Containing complete
information

Bitmap BMP Including both Windows and
0OS/2 bitmaps.

Independent JPEG | JPG Least loss and highest quality

Group when decompressing.

Tagged Image File | TIF Reading the first page only.

Format

Portable Bitmap PBM Reading both ASCII and binary
formats.

Portable Gray Map | PGM Reading both ASCII and binary
formats.

Portable Network PNG

Graphics

Portable Pixel Map | PPM

Targa File TGA

Dr. Halo CUT

Windows Icon ICO Reading the first page only.

Amiga IFF IFF/LBM

JPEG Network ING

Graphics

Commodore 64 KOA

Koala Format

Multiple Network MNG

Graphics

Kodak Photo CD PCD Extracting only maximum
resolution.

PCX Bitmap Format | PCX

Adobe Photoshop PSD

SUN Raster File RAS

Wireless Bitmap WBMP

X11 Bitmap Format | XBM

X11 Pixmap Format | XPM

Metallograph MEG Containing calibration and

magnification information.

Note the native format (*.sif) preserves the most complete
information for images acquired by Optika™ Vision Pro, including
sampling interval and magnification settings. The Metallograph
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format (*.meg) also contains such information. However, the other
formats do not contain metrical information and cannot be measured
in a physically meaningful manner. When such a file is opened, the
sampling interval is assumed to be 1 micron and the magnification is
assumed to be 100X.

Close

Use the Close command to remove the active image window.

If the active image window is the only image window, closing this
window will cause Optika™ Vision Pro to switch to Main Frame
Menu. To go back to Document Menu, choose File > New for Video
Preview to create an empty image window, or choose File > Open to
load an image file.

Save

Use the Save command to store the active image onto disk in the
native format.

If the active image has been previously saved in the native format
(*.sif), this command will update the corresponding file quietly. If the
image has never been saved in the native format, this command will
act as File > Save As.

Save As

Use the Save As command to store the active image onto disk with a
new file name or in a new format.

The native image format (*.sif) and Metallograph format (*.meg)
retains both pictorial and metrical information and are the best for
archival purpose. The other image formats keep pictorial information
only.

The supported image formats are listed below.
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Format File Remark
Extension
Native SIF Containing complete
information.
Bitmap BMP Writing in Windows Bitmap
format.
Independent JPEG JPG Least loss and highest quality
Group when compressing.
Tagged Image File TIF Writing as single-page.
Format
Portable Bitmap PBM Writing in binary format.
Portable Gray Map PGM Writing in binary format.
Portable Network PNG
Graphics
Portable Pixel Map PPM Writing in binary format.
Targa File TGA
Metallograph MEG Containing calibration and

magnification information.

JPEG Options

Use the JPEG Options command to specify the desired image quality
when storing images in JPEG format.

This command brings up the dialog shown below.

JPEG Options

Image Cuality

{(*) Best
() Good
() Moderate

() Awerage
() Limnited

Cancel
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The better the image quality, the less the compression ratio. Five
levels of image quality are provided. The “Best” image quality
corresponds to the largest file size.

Print Setup

Use the Print Setup command to select a printer and set its properties
for use with image hardcopy output.

Print Image Layout

Use the Print Image Layout command to specify whether all images
or only the active image should be printed and the way each image is
to be aligned and scaled.

This command brings up the dialog shown below. All settings will be
saved automatically for later use in the current and later sessions.

Fa

Image Layout
Aligriment v 0K
() At (Al Images Automatically Aligned) ¥ Cancel

{7 CAP [Curent Image Absolutely Positioned)
{%) CFP [Current Image Fit to Paper]

Zoom for Add and CAP

1

Dizplacement for CAP [mm)

Haorz |0 Wert 0
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Alignment

This section determines whether all images or only the active image
might be printed. Three modes are defined by Optika™ Vision Pro :
AAA (All Images Automatically Aligned), CAP (Current Image
Absolutely Positioned) and CFP (Current Image Fit to Paper).

e AAA. Under this mode, all images except empty ones would
be printed. The layout and pagination of images are fully
automatic. A zoom factor may be applied to all images before
the final page layout is calculated. The zoom factor is
specified in Zoom for AAA and CAP. The titles would also
be printed under images.

e CAP. Under this mode, the active image would be printed if it
is not empty. The size and position of the printed image may
be modified. The image may be zoomed according to the
factor specified in Zoom for AAA and CAP. The image can
be placed anywhere on the paper. The position of the printed
image refers to the horizontal and vertical offset of the top left
corner of the image with respect to the top left corner of the
printable area of the paper, in millimeters. The offsets are
specified in Displacement for CAP (mm).

e CFP. Under this mode, the active image would be printed if it
is not empty. The image is automatically scaled to fill the
width or height of the paper, depending on aspect ratios of the
image and paper. The aspect ratio of the image is kept
constant. If the image could not occupy the whole printable
area of the paper, it will be placed to the top side as far as
possible but centered horizontally in the paper.

Zoom for AAA and CAP

This section specifies a zoom ratio of the images for use with printing
under AAA and CAP modes.

Displacement for CAP (mm)

This section specifies offsets of the image for use with printing under
CAP mode. The origins of the image and paper are their top left
corners. Horizontal displacement is defined as the distance between
the leftmost column of the image and the left side of the paper’s
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rectangular printable area. Vertical displacement is defined as the
distance between topmost row of the image and the top of the paper’s
rectangular printable area. The distance is measured in millimeters.

The Print Image Layout command is used to configure the printing
but it does not initiate a printing process.

Print Preview

Use the Print Preview command to simulate image printing on
computer screen.

In this mode, Optika™ Vision Pro menu, toolbars, auxiliary windows

except the Control Panel are hidden as illustrated below.

Conkrol Panel %Pnnt i ma e
@ @ (&} | 1maging Control -

Capture Control £y
I ™
Presst Add

(») videoOn () Video Dff

S MeasE  F eawB

Biaz |0 % E Capture
Light Source Frequency

O65Hz: O&MHz @DC

[ Continuous Auto Exposure

Time Lapse &

e | 0[S ]
Duration ljl (€] m

Note that an enhanced print preview toolbar appears. There are seven
buttons, the function of each is explained below.

&E”"‘It r _JJ ':il, = Close

ié. Print Click to start the actual printing.
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Click to view the next page

Click to view the last page

Click to toggle between two-page view and single-

- page view.
"53, Click to zoom in the image
Click to zoom out the image
Close Click to exit the print preview mode. This is equivalent

to pressing Esc key.

The status bar will be displaying the page number of the image being
previewed.

The main window now shows the print layout of the images. Print
preview has incorporated configurations set by both Print Setup and
Print Image Layout.

Print

Use the Print command to output a hardcopy of the active image or
all opened images.

This command only initiates the printing process and does not specify
how the printing should be done. The printer selection and
configuration is carried out by Print Setup. The digital zoom factor,
position and alignment of images are specified by Print Image Layout.

Toggle Preview

Use the Toggle Preview command to turn on or off video streaming.

Optika™ Vision Pro employs an empty image window to display live
images. Such a window is created automatically upon program
startup. To create a new empty image window, choose File > New for
Video Preview. The caption of the window indicated the model and
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serial number of the presently connected camera. At any time one
empty image window at most can be used to preview video. Choose
Toggle Preview again to shutdown the video. If it is desired to
preview video in a particular empty image window, make that image
window the active image window and choose Toggle Preview.

Equivalent Commands

From Capture Control Sub-Pane

r

W

Prezet Add

(») VideaOn () Video Off

[ Auto Expozure ] [‘-.-'-.-’hite B alance ]

+..,_ Area AE f Area \Wh

Biazs 0 = 1@, Capture

Light Source Frequency
(JBOHz () EOHz () DC

[ ] Cortinuous Auta Esposure

_ . Push to turn on live image preview on an empty
) Video On image window. If there is currently no empty
image window, a new one will be created.
- Push to turn off live image preview.
(1) Video OFf P
Capture
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Use the Capture command to acquire an image from the camera
based on the present camera settings and capture options.

The camera settings include exposure time, global gain, color gains,
Gamma, saturation, hue, brightness, contrast, image orientations, and
light source temperature. For more details please refer to respective
commands that set these parameters.

The capture options include frame averaging, decimation, where to
store the captured images and so on. For more details please refer to
the Capture Options command.

Equivalent Commands

1 Shortcut

Double-click the empty image window that is displaying video.

2 From Capture Control Sub-Pane

*

W

Prezet Add

(») VideaOn () Video Off

[ Auto Expozure ] ['W'hite Balance ]

~..,_ Area AE Af Area'wh

Bias 0 = 1@ Capture

Light Source Frequency
(JB0Hz (O EOHz () DC

[ ] Continuouz Auto E xpozure
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Fo| Captue Push to acquire an image from the camera based
— F on the present camera settings and capture
options.

LUT > Apply

Use the LUT > Apply command to activate or deactivate the LUT of
the camera.

If the LUT is presently enabled, this command will disable it. If the

LUT is presently disabled, this command will enable it. This
command will not modify the LUT.

LUT > Reset

Use the LUT > Reset command to set the LUT to its default state.

The default LUT is a linear mapping from the full dynamic range of
the camera to 8 bits.

LUT > Define

Use the LUT > Define command to bring up a dialog box where the
coordinates of the controlling points may be entered directly.

= =]

LUT for Camera
w1 0141 [0.1] «2 0622 [01] =2%1:01 & 0K
vl 0425 [01]  y2 0905 [0]] % Cancel

Note that the coordinates need to be within [0, 1] and the x2-x1>0.1.

Fluorescent Special > 3-Channel
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Use the Fluorescent Special > 3-Channel command to switch the
camera to the imaging mode that all the red, green and blue channels
are activated.

Fluorescent Special > Green Red

Use the Fluorescent Special > Green Red command to switch the
camera to the imaging mode that only green and red channels are
activated.

Fluorescent Special > Green Blue

Use the Fluorescent Special > Green Blue command to switch the
camera to the imaging mode that only green and blue channels are
activated.

Exit
Use the Exit command to close Optika™ Vision Pro.

This command prompts to save modified documents. Optika™ Vision
Pro considers an image as a modified document if it has never been
saved in native format or it has been processed or measured after the
last time it was saved.

Viewing an image in different ways, measurement in progress (not
yet completed) and annotating an image (before the annotation
objects are burned into images) are not considered as modifying an
image.
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The Edit Menu

Optika™ Vision Pro maintains a processing history for each image.
The processing history is a chain of internal buffers holding the states
of the image. A new state of the image is automatically created and
appended to the processing history after each operation that has
modified that image. Viewing an image in different ways,
measurement in progress (not yet completed) and annotating an
image (before the annotation objects are burned into images) are not
considered as modifying an image.

Undo

Use the Undo command to reverse the most recent action that has
modified the image.

The possible number of undo steps is the length of processing history.

Redo

Use the Redo command to undo an Undo operation.

Copy to Clipboard

Use the Copy to Clipboard command to convert a copy of the active
image to Windows Bitmap format and place it on the clipboard.
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The View Menu

The commands in this group are used to customize the appearance of
user interface elements, images and computer screen.

Toolbars and Auxiliary Windows

Use the Toolbars and Auxiliary Windows commands to toggle the
visibility of each toolbar or auxiliary window.

Toolbar Auxiliary Window

Standard Control Panel

Image Processing Help Desk

Image Measurement Database

Image Annotation Measurement
Histogram

A toolbar can be either visible or hidden. When it is visible, it can be
either docked or floating. The menu can also be docked or floating,
although it cannot be hidden.

Drag its grip to adjust the position of a toolbar or the menu. Double-
click on its grip to toggle the dock state of a toolbar or the menu.

Control Panel can be visible or hidden. However, it is always docked
to the left side of the main window. Control Panel can be resized but
cannot be floating or docked to any other side of the main window.
The other auxiliary windows can be either visible or hidden. When
they are visible, they can be either docked or floating. Drag their

captions to adjust their positions. Double-click on their captions to
toggle their dock states.

Status Bar

Use the Status Bar command to toggle the visibility of the status bar.
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Auxiliary Window Captions

Use the Auxiliary Window Captions command to turn on or off the
Windows Themes on all the auxiliary windows.

Optika™ Vision Pro is able to draw the captions of the auxiliary
windows in its own way but also accepts Windows Themes for its
auxiliary windows. If Auxiliary Window Captions is unchecked as is
the default, Optika™ Vision Pro will draw the captions of auxiliary
windows in its own way which in a sense is more convenient to use.
However, if Auxiliary Window Captions is checked, Optika™ Vision
Pro will draw the captions of auxiliary windows according to the
current Windows Themes.

This command merely affects the appearance of the auxiliary

windows and does not limit their functionalities.

Image Window Tabs

Use the Image Window Tabs command to toggle the visibility of
image window tabs.

Image windows can have or have not tabs. When an image window
has a tab, the tab can either appear on top or at bottom of the main
window. Choose Image Window Tabs to hide the tabs if the image
windows currently have tabs. Choose Image Window Tabs to show
the tabs if the image windows currently do not have tabs.
Equivalent Commands

Image Window Tab Context Menu

Use Hide Tabs to remove image window tabs currently shown in the

main window.

Image Window Size

Use the Image Window Size command to set the active image
window to a specific dimension.
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This command brings up the following dialog:

e o

Window Size

widthin Pivels |40
Heightin Pisels | 450

If the OK button is pressed, the client area of the active image
window will be changed to the given size.

Overlay

Use the Overlay command to toggle the visibility of measurement
and micrometer overlays.

A successful measurement operation creates graphics overlay on the
image. This overlay is on a separate layer from pixels. The overlay
layer can be either shown or hidden. Choose Overlay to remove the
overlay view currently superimposed on the picture. Choose Overlay
again to restore. This command affects the visibility of the overlay
layer only and does not delete the overlay.

Overlay Color

Use the Overlay Colors command to set a new color for the overlay
layer.

The overlay layer can be shown in different colors after it have been
created. To select a new color, choose Overlay Colors and pick up a
desirable one.

This command is special in that a dialog appears in place of a popup
menu item, as shown below.
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Cryerlay

Creerlay Colar, .. 3 e

Cwerlay Size... | L] Automatic |

EEEEEEER

[:::] Centre EEEEREEERN

Corner AR HEEEEN
o DEONEEED
R Fit bo Window OOO0O00 8O

Zoom Preview.., More Colors, ..

The dialog is initially docked to the menu item Overly Color,
however, if desired it can be made floating by dragging its grip.

(|
Overlay Color... | |

|||:| Automatic

ENEEEEER
EEEEEEER
EEEEEEER
OECOHNNNENEE
OO000C NN

Mare Colors. ..

The dialog in two different dock states behaves in exactly the same
way.

Click “Automatic” to select the color white as the overlay color.
Click any of the color boxes to select that color as the overlay color.
Click “More Colors” for more choices or to create a new color. Click
“More Colors” will bring up another dialog as shown next.
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-

Colors

Standard | Custom

Colors:

IE
.~
X

Cancel

M e

Current

Again, click a hexagon to pick up its color as the new overly color.
The present overlay color is shown in a box at the bottom right corner
of the dialog box. The present selection is shown in the box above the
present overly color box.

Push OK to dismiss the dialog and set the new color as overlay color.
Push Cancel to dismiss the dialog with overlay color remaining the
original.

If it becomes necessary to create a unique color, click “Custom” to
switch to the other tab of this two-tab dialog box, as shown below.
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[
Colors

Standard | Custorn

Colors:

M e

Current

Click or drag to adjust hue and
saturation of the currently
selected color.

Click or drag to adjust
luminance (intensity) of the
currently selected color.

Show the hue of the currently
selected color. The hue value
can also be entered directly or
adjusted with the spin buttons.
The hue is in the range [0,255].

36

www.optikamicroscopes.com




Sat |255 |

<l

Show the saturation of the
currently selected color. The
saturation value can also be
entered directly or adjusted
with the spin buttons. The
saturation is in the range
[0,255].

Lum: (128 [

Show the luminance or
intensity of the currently
selected color. The luminance
or intensity can also be entered
directly or adjusted with the
spin buttons. The luminance or
intensity is in the range
[0,255].

Bed: | 255 2:2

Show the red of the currently
selected color. The red value
can also be entered directly or
adjusted with the spin buttons.
The red is in the range [0,255].

Green: | 255 ;:;

Show the green of the
currently selected color. The
green value can also be entered
directly or adjusted with the
spin buttons. The green is in
the range [0,255].

Blue: |0 ;:;

Show the blue of the currently
selected color. The blue value
can also be entered directly or
adjusted with the spin buttons.
The blue is in the range
[0,255].

MNew Show the currently selected
color.
Show the currently overlay
color.
Current
Push to dismiss the dialog and
Ok set the selected/created color
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as the new color for displaying
overlay.

Push to dismiss the dialog and
Lancel discard any changes made
during the dialog.

Overlay Size

Use the Overlay Size command to change the line width and font size
for graphics generated by subsequent measurement operations.

All measurement operations generate graphical overlays. Most of the
measurement operations also generate textual annotation objects
describing the quantitative output of the measurement.

In addition, measurement may be carried out in either “browsing”
mode or “focusing” mode of image display. In browsing mode, the
full field of view is visible, albeit possibly in a reduced resolution. In
focusing mode, maximal details are shown, although the field of view
may be partially visible.

f ™

Overlay Size
Line Fitch 1 v 0K
Text Size 2 ¥ Cancel
[ ] Auta Zoom
Line Pitch 1 A relative scale of the pen width for

graphical overlay.

A relative scale of font for textual

Teut Size 2 annotation objects generated during
measurement process.
If checked, both line pitch and text
[ ] Auto Zoom size will be re-scaled according to
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zoom ratio currently used for
displaying the image being
measured.

Push to close the dialog and apply
v DK the settings to subsequent
measurement.

Push to close the dialog and discard
the changes to overlay size made
during the dialog.

}( Cancel

Centre

Use the Centre command to place the centre of the image at the
centre of the image window.

Corner

Use the Corner commands to place a corner of the image at the centre
of the image window.

Fit to Window

Use the Fit to Window command to toggle between browsing and
focusing mode of image display.

In browsing mode, the full field of view is visible, albeit possibly in a
reduced resolution. In focusing mode, maximal details are shown,
although the field of view may be partially visible.

Browsing mode is best for finding the right field of view to capture.
Focusing mode is best for finding the right focus position.

Zoom Preview

Use the Zoom Preview command to toggle the visibility of the zoom
preview window.
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Zoom Preview ﬁ

: oo 300(22)

The zoom preview window is a floating window created
automatically by Optika™ Vision Pro upon startup. It magnifies a
small region of an image. The magnification rate is adjustable with
the slider at the bottom of the zoom preview window. The zoom
preview window works on both still image and live image. The
region to magnify is set by current mouse position.

Screen Gamma

Use the Screen Gamma command to adjust the Gamma of the
computer screen.
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F S

Screen Gamma
_“. v 0K
1 100 400 ¥ Cancel
J Use the slider to set a new Gamma value.
1 The minimal allowable screen Gamma,
corresponding to the physical value 0.01.
100 The current screen Gamma, scaled up by 100.
400 The maximal allowable screen Gamma,

corresponding to the physical value 4.

v  OK Push to dismiss the dialog and keep the screen
Gamma setting.

Push to dismiss the dialog and discard any
modification to screen Gamma made during the
dialog.

x Cancel

Equivalent Commands
1 From Settings File

Upon startup Optika™ Vision Pro will load the screen Gamma setting
used last time. Upon exit Optika™ Vision Pro will store the screen
Gamma value to a private settings file.

2 From Help > Settings
Any change made to screen Gamma will be shown when this dialog

is open. Any change made to screen Gamma during this dialog will
be effective when Optika™ Vision Pro runs next time.
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The Database Menu

A full-featured database system has been built into Optika™ Vision
Pro. The database is accessible whenever Optika™ Vision Pro is
running. All the information content of an image, together with its
quantitative result of measurement, date of creation, author, and
textual description may be archived in the built-in database.

Optika™ Vision Pro uses a caption to uniquely identify each record in
the database. User specifies a caption for each image that is being
stored to database. Besides the caption, there are three other fields in
each record. Date is the time of creation of the record. Author is the
name of the operator that has captured or processed the image.
Description is a single line of text usually explaining the image or the
measurement performed over the image.

When a new record is created for an image, the quantitative result of
any measurement done so far for the image, as shown in the auxiliary
window Measurement, will also be saved to database.

The built-in database is fully controlled from the corresponding

auxiliary window. The menu duplicates some of the more frequently
used commands.

Store

Use the Store command to save the active image and its measurement
result to the built-in database.
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-

[Database

Caption
Alloy-10008:

Date
2007- 2- 1 ]

Aithor
Jack

Description

The material to be uzed in Micrometrics camera housing

Add

Caption
Alloy-100008

Specify a caption for the record
to create. Must be a single line
of text. The title of the active
image is initially displayed but
it is free to specify a different
one. The caption should be
unique within the database.
Otherwise a warning message
appears as shown below.
Answer Yes to replace the
existing record with the same
caption. Answer No to abort
the storing operation.

9

1..(/ Database already contains a record capkioned "Alloy- 1000 ', wwould vou like to replace the record 7

o ]

D ate
2007- 2- 1 ]

Specify the date of creation of
the record. The date initially
shown is that of the computer.
Click to pick up another date as
illustrated below.
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P

Database

Caption
A lloy-1 0000

Date
24 1/2007

< | February, 2007

1]
4 5 B 7 8
1112 13 14 15
18 19 20 21 22
25 2% 27 28

[ |Today: 2172007

[

A date may also be entered
directly.

ALthar
Jack

Specify the name of the person
who is responsible for the
acquisition, processing or
measurement of the active
image. Must be a single line of
text.

Description

The material to be uzed in Micromet

Specify a single line of text as a
note, remark or comment.

Add

Push to add the new record to
database.

-

Push to exit the dialog and do
not modify the database.
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Load

Use the Load command to open the selected record in the database.
Note that a record in the database must have been selected for this

command to work. Otherwise a warning message will appear as the
following.

! ': Flease select a record |
[ ]

When a record is successfully loaded, a new image window will be
created to hold the image data from that record. If the image has been
measured before, measurement information will also be loaded into
the auxiliary window Measurement.

Delete

Use the Delete command to delete the selected records in the
database.

For this command to work, at lease one record has to be selected.
Otherwise, the following warning message appears.

! '-_.,, Flease select a record |
[ ]

A deleted recorded cannot be restored.

Refresh

Use the Refresh command to reset the record list to its default state.
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Upon startup, the auxiliary window Database shows the most recently
added records, up to 100 entries. After a query has been made on the
database, the auxiliary window Database shows the query result.
Choose Refresh to list the records in order of their creation.
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The Field Menu

The Field Group of Optika™ Vision Pro is a buffer of images with a
thumbnail displayed for each image. Field Group can be a destination
of acquired images. Images in Field Group can also act as the input to
a multi-operand image processing operation.

The Field Group is a complementary means of image organization.
While an image in an Image Window can be more readily viewed or
processed, the Field Group provides the concept and infrastructure of
an ordered set of images. Optika™ Vision Pro has a mechanism for
exchanging data between Field Group and Image Window.

Open

Use the Open command to load images from a Field Group File
(*.fov).

A Field Group File (*.fov) is a file format used to hold the content of
the Field Group. Successfully loaded images from a Field Group file
will be appended to the Field Group. Note that images in Field Group
File are also properly ordered as in the Field Group, so the

successfully loaded images will be appended to the Field Group in
that order.

Save

Use the Save command to store the content of Field Group to a Field
Group File (*.fov).

A Field Group File (*.fov) is a file format used to hold the content of
the Field Group.

Import

Use the Import command to load image files to Field Group.
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This command is capable of opening multiple image files, subject to
the conditions that these files reside in the same folder and are in the

same format. The acceptable file formats are listed below.

Windows Bitmap *.bmp

JPEG *.]pg

TIFF *tif Load first page only.

Dr. Halo *.cut

Icon *.ico Load first page only.

Amiga IFF * iff,

*.Ibm

JPEG Network Graphics | *.jng

Commodore 64 Koala *.koa

Format

Multiple Network *.mng

Graphics

Portable Bitmap *.pbm Recognize both text and
binary format.

Kodak Photo CD *.pcd Load maximal resolution
only.

PCX Bitmap *.pcx

Portable Graymap *.pgm Recognize both text and
binary format.

Portable Network *.png

Graphics

Portable Pixelmap *.ppm Recognize both text and
binary format.

Adobe Photoshop *.psd

Sun Rasterfile *.ras

Targa *.1ga

Wireless Bitmap *.wbhmp

X11 Bitmap *.xbm

X11 Pixmap *.Xpm

Export

Use the Export command to save images in Field Group to disk.
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The images in the Field Group will be saved in turn. For each image a
File Save As dialog is open with a default file name. It is possible to
change file name, format and location on disk separately for each
image. The acceptable file formats are listed below.

Windows Bitmap *.bmp

Independent JPEG Group | *.jpg | Least compression applied.
TIFF *tif | Save as single page.
Portable Bitmap *.pbm | Save in binary format only.
Portable Graymap *.pgm | Save in binary format only.
Portable Network Graphics | *.png

Portable Pixelmap *.ppm

Targa *.1ga

Append

Use the Append command to add the active image to the end of Field
Group.

The Field Group is limited in both pre-allocated memory and number
of thumbnails. When there is no room for another image, the Append
command fails quietly.

The Field Group retains all information of the image, including
metrical and magnification settings.

Equivalent Command

Double-click within the active image window.

Load

Use the Load command to open the selected image in Field Group.

A new image window will be created to hold a copy of the image in
Field Group. The image in Field Group will not be removed.

Equivalent Command
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Double-click within the thumbnail of the image in Field Group.

Selecting an image in Field Group
1 Click within the thumbnail.

2. Hover over the thumbnail for 2 or more seconds.

Move Up

Use the Move Up command to swap the selected image in Field
Group with the preceding one.

Equivalent Command

Right click the thumbnail to bring up Field Group Context Menu, and
choose Move Up.

Selecting an image in Field Group
1 Click the thumbnaill.

2. Hover over the thumbnail for 2 or more seconds.

Move Down

Use the Move Down command to swap the selected image in Field
Group with the following one.

Equivalent Command

Right click the thumbnail to bring up Field Group Context Menu, and
choose Move Down.

Selecting an image in Field Group

1 Click the thumbnail.
2. Hover over the thumbnail for 2 or more seconds.
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Clear

Use the Clear command to remove the selected image from the Field
Group.

Equivalent Command

Right click the thumbnail to bring up Field Group Context Menu, and
choose Clear.

Selecting an image in Field Group
1 Click the thumbnail.

2. Hover over the thumbnail for 2 or more seconds.

Clear All

Use the Clear All command to empty the Field Group.
Equivalent Command

Right click the thumbnail to bring up Field Group Context Menu, and
choose Clear All.

Selecting an image in Field Group

1 Click the thumbnail.
2. Hover over the thumbnail for 2 or more seconds.

Show Previous

Use the Show Previous command to display the currently selected
image of Field Group in the active image window and then select the
preceding image in Field Group.

For this command to work, the selected image in the Field Group

must have the same numbers of columns and rows of pixels and
number of color channels as the active image, otherwise, the

o1
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command fails quietly but the internal index will be decremented, so
next time the command is executed it can find the right image to
display.

The Show Previous command replaces the image in the active image
window by the selected image in the Field Group. Note that only
pictorial data are replaced and the other layers such as graphical
overly are kept intact. This facilitates the comparing of multiple
images.

Show Next

Use the Show Next command to display the currently selected image
of Field Group in the active image window and then select the
following image in Field Group.

For this command to work, the selected image in the Field Group
must have the same numbers of columns and rows of pixels and
number of color channels as the active image, otherwise, the
command fails quietly but the internal index will be incremented, so
next time the command is executed it can find the right image to
display.

The Show Next command replaces the image in the active image
window by the selected image in the Field Group. Note that only
pictorial data are replaced and the other layers such as graphical

overly are kept intact. This facilitates the comparing of multiple

images.

Panorama Landscape

Use the Panorama Landscape command to stitch a row of images.

The images to stitch should have been stored in Field Group, and
ordered correctly. All images in Field Group participate in the
operation. These images must be identical in the numbers of columns
and rows of pixels and the number of color channels. The first image
in Field Group should be the leftmost image of the row of images to
be aligned. The last image in Field Group should be the rightmost
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image of the row of images to be aligned. There must be at least two
valid images in Field Group.

In addition, any two adjacent images must have at least 20% non-
overlapping areas and at least 32 overlapping columns of pixels. The
images are allowed to shift vertically but the shift has to be limited to
16 rows of pixels.

A new image window will be created to hold the output panorama
image. The output image copies the sampling intervals and
magnification setting from the first input image from Field Group.
Due to the overlapping of the input images, the number of columns of
the output image would be less than those of input images summed.
Due to possible vertical shift of the input images, the number of rows
of the output image might also be less than that of an input image.
The cropping is automatic and transparent to users.

The example below illustrates the process. The first three images are
stitched to create the forth image.

Panorama Portrait

Use the Panorama Portrait command to stitch a column of images.

The images to stitch should have been stored in Field Group, and
ordered correctly. All images in Field Group participate in the
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operation. These images must be identical in the numbers of columns
and rows of pixels and the number of color channels. The first image
in Field Group should be the topmost image of the column of images
to be aligned. The last image in Field Group should be the
bottommost image of the column of images to be aligned. There must
be at least two valid images in Field Group.

In addition, any two adjacent images must have at least 20% non-
overlapping areas and at least 32 overlapping rows of pixels. The
images are allowed to shift horizontally but the shift has to be limited
to 16 columns of pixels.

A new image window will be created to hold the output panorama
image. The output image copies the sampling intervals and
magnification setting from the first input image from Field Group.
Due to the overlapping of the input images, the number of rows of the
output image would be less than those of input images summed. Due
to possible horizontal shift of the input image, the number of columns
of the output image might also be less than that of an input image.
The cropping is automatic and transparent to users.

The example below illustrates the process. The three images on the
left are stitched to create the image on the right.
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Multi-Focus Composition

Use the Multi-Focus Composition command to create a best focused
image from partially focused images in Field Group.

The partially focused images, at least two, must have been cached in
Field Group. All images in Field Group will contribute to the focus of
the output image. These input images must be identical in the
numbers of columns and rows of pixels and the number of color
channels.

For the multi-focus composition to work, the active image must also
have the same number of columns and rows of pixels and the same
number of color channels. When the computation starts, the active
image will be replaced by the first image in the field group. As the
following images in field group are aligned and fused with the
previous ones, the active image will be replaced by the current state
of the focus combination.

There are two concatenated stages of multi-focus composition. The
first stage is the registration of the two adjacent images and the
second stage is the fusion of two images. The registration is the
process to correct the image displacement. It is used only when
imaging with stereomicroscopes. The fusion is the heart of multi-
focus composition and is common to all types of microscopy.

The Multi-Focus Composition command brings up the following
dialog box. For images acquired from compound microscopes (with
vertical objectives), simple press “Start” button. To fuse images
acquired from stereomicroscopes, a single parameter, “Maximum
Step Displacement”(MSD) needs to be set before pressing “Start”
button. This parameter should be set as an upper bound of the
translation, in pixels, between any two adjacent images. Note it is not
absolutely necessary to specify a precise value for the MSD as it is
used only as a hint to the computation process for efficiency purpose.
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Multi-Focus Compaosition

b amimum Step Displacement a

Index " y Time

After the “Start” button is pressed, the computation starts. The
intermediate results are given in both the dialog box and the active
image, as shown below. First of all, the “Start” button changes to the
“Abort” button. If it is pressed, the computation will be terminated
with whatever the intermediate image left as the active image. The
table in the middle of the dialog box shows the displacements
detected from the input images. The first column shows the index of
the image in Field Group that has just been registered and fused. The
second column shows the horizontal displacement detected and the
third column shows the vertical displacement detected. The fourth
column shows the time, in milliseconds, used for the registration and
fusion. When 0 is specified as the MSD, i.e. when fusing images
acquired from a compound microscope, no registration is performed
and O is set as displacement. When a non-zero MSD is specified, i.e.
when fusing images acquired from a stereomicroscope, and when the
detected displacement is equal to MSD, the specified controlling
parameter might be too small and the computation should probably
be terminated and re-started with a greater MSD. The progress of the
computation is shown at the bottom of the dialog box.
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b amimum Step Displacement
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A new image window will be created to hold the output image. The
output image has the same metrical and magnification settings as
those of the first image in the Field Group.

The example below illustrates the process. The two images on the left
are the first and the last of a stack of 29 images gathered over the
same field of view, and the image on the right is the fusion of the
image stack.
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Vector Arithmetic > Combine

Use the Vector > Combine command to compose a color image from
the last three images in the Field Group.

The last three images are assumed to be the red, green and blue
channels of a color image. As such, they must be identical in the
numbers of columns and rows of pixels. It is not required that these
images are all color or all monochrome. If a color image is in place,
only its first channel, i.e. red, will be extracted.

A new image window will be created to hold the output image. The

output image has the same metric and magnification setting as those
of the last image in the Field Group.

Vector Arithmetic > Split

Use the Vector > Split command to decompose a color image into
three monochrome images representing its red, green and blue
channels.

The output images are appended to the Field Group.

Vector Arithmetic > Subtract

Use the Vector > Subtract command to subtract the active image
from each image in Field Group.

For this command to work, each image in the Field Group must have

the same numbers of columns and rows of pixels and number of color
channels as those of the active image. The output images will replace

those corresponding images in the Field Group. Negative pixel values
are truncated to zero.

Vector Arithmetic > Divide

Use the Vector > Divide command to divide each image in Field
Group by the active image.
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For this command to work, each image in the Field Group must have

the same numbers of columns and rows of pixels and number of color
channels as those of the active image. The output images will replace

those corresponding images in the Field Group. If there is a zero pixel
in the active image this command fails quietly. The output image will
be scaled in intensity to make it approximately the same brightness as
those of the input images.

Vector Arithmetic > Max

Use the Vector > Max command to create a pixel-wise channel-wise
maximal value image from all images in the Field Group.

For this command to work, all images in Field Group must be
identical in the numbers of columns and rows of pixels and the
number of color channels, and there must be at least two images in
the Field Group.

A new image window will be created to hold the output image. The
output image has the same numbers of columns and rows of pixels
and the same number of color channels. The value of each color
component (channel) of each pixel of the output image is set as the
greatest of all corresponding values from all images in the Field
Group.

The output image has the same sampling intervals and magnification

setting as those of the first image in the Field Group.

Vector Arithmetic > Min

Use the Vector > Min command to create a pixel-wise channel-wise
minimal value image from all images in the Field Group.

For this command to work, all images in Field Group must be
identical in the numbers of columns and rows of pixels and the
number of color channels, and there must be at least two images in
the Field Group.
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A new image window will be created to hold the output image. The
output image has the same numbers of columns and rows of pixels
and the same number of color channels. The value of each color
component (channel) of each pixel of the output image is set as the
least of all corresponding values from all images in the Field Group.

The output image has the same sampling intervals and magnification
setting as those of the first image in the Field Group.

The example below illustrates the process. The first image is pure
green simulating a microscope filter. The second image is a raw
image captured for a specimen. The third image is the output of the
Min operation with the previous two images as input.

Vector Arithmetic > Average

Use the Vector > Average command to create a pixel-wise channel-
wise mean value image from all images in the Field Group.

For this command to work, all images in Field Group must be
identical in the numbers of columns and rows of pixels and the
number of color channels, and there must be at least two images in
the Field Group.

A new image window will be created to hold the output image. The
output image has the same numbers of columns and rows of pixels
and the same number of color channels. The value of each color
component (channel) of each pixel of the output image is set as the
mean of all corresponding values from all images in the Field Group.

The output image has the same sampling intervals and magnification
setting as those of the first image in the Field Group.
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The Adjust Menu

Image Gamma

Use the Image Gamma command to adjust the Gamma of the active
image or the camera.

-

Image Gamma

=,

D v 0K
0.1 112 4 # Cancel
Use the slider to specify a factor to be multiplied
................. ...J to the original Gamma of the active image.
0.1 The minimal allowable multiplier.
112 Show the current factor being multiplied to the
: original Gamma of the active image. A value can
also be entered directly.
4 The maximal allowable multiplier.
v 0K Push to dismiss the dialog and finalize the
modification to the Gamma of the active image.
%  Cancel Push to dismiss the dialog and discard any
' modification to the active image.

If the active image

is an empty image and the active image window is

streaming video, the Image Gamma command actually sets the
Gamma value of the camera.

P

Image Gamma

-,

X

d

0.0

et K

075 4] 7 Cancel

Use the slider to set the Gamma of the camera.
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0.m The minimal Gamma value applicable to the
present camera.

0.75 Show the current Gamma setting of the camera. A
: value can also be entered directly.
5 The maximal Gamma value applicable to the

present camera.

v 0K Push to dismiss the dialog and keep the new
Gamma setting for the camera.

¥ Carcel Push to dismiss the dialog and discard any change
' to the camera settings during the dialog.

Image Temperature

Use the Image Temperature command to set a new color temperature
to be used in white balance.

This command brings up a color palette as shown below:

Inmage Temperature... EI

Aukornatic

Click a color box to select a temperature, or click “Automatic” to
signify no temperature should be incorporated in white balance. The
easiest way to determine the needed temperature is to pick the color
box which has the same color as a white object illuminated by a
specific light source.

Area Based White Balance

Use the Area Based White Balance command to correct color
aberration of the active image or the camera.

Correction of color reproduction is based on the values of a small

rectangular neighborhood of pixels. These pixels should be colorless
but instead are showing a tint. Optika™ Vision Pro will calculate the
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relative strength of each color component and adjust the color gains
accordingly.

Click a pixel within the active image to indicate to Optika™ Vision
Pro the centre of the neighborhood on which color correction will be
based.

If the active image window is displaying live images from the camera,
this command performs area based white balance for the camera.

Equivalent Commands

From Camera Control Sub-Pane

*

W

Prezet Add

(») VideaOn () Video Off

[ Auto Expozure ] ['W'hite Balance ]

~..,_ Area AE Af Area'wh

Bias 0 = 1@ Capture

Light Source Frequency
(JB0Hz (O EOHz () DC

[ ] Continuouz Auto E xpozure

f Area WE Push to perform white balance based on a small
rectangle within the visible portion of the live
image. The operation is completed by a click on
the live image, which specified the center of the
rectangle on which the white balance will be
based. The width and height of the rectangle is
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the smallest region of interest that is supported
by the camera.

Interactive

Use the Interactive command to adjust the intensity, saturation and
hue of the active image or the camera.

-

-,

Interactive Adjustment
[rkenzity ] v DK
-285 0 255 . Cancel
Saturation _j
_25F il 255
Hue J
-285 0 255

[Frkerzity

Indicate the intensity of the image is being adjusted.
The intensity of a pixel is in the range [0,255]. Values
out of the range will be truncated.

S aturation

Indicate the saturation of the image is being adjusted.
The saturation of a pixel is in the range [0,255].
Values out of the range will be truncated.

Hue

Indicate the hue of the image is being adjusted. The
hue of a pixel is in the range [0,255] and is cyclic
with a period of 256.

J

Use the slider to adjust a color component.

-255

Minimal allowable amount that can be added to a
color component.

Show the current amount that is being added to a
certain color component of all pixels. A value may be
entered directly.

255

Maximal allowable amount that can be added to a
color component.

v  OK

Push to close the dialog and finalize the adjustments
to the active image.
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¥ Cancel

Push to close the dialog and discard any modification
to the active image.

If the active image window is empty and is streaming video, the
Interactive command adjusts the gain, saturation and hue of the

camera.
Interactive Adjustment
Intenzity ;i v 0K
1 B.045 16 X Carcel
Saturation _j
0 0.5 1
Hue
0 0

Intensit Indicate the gain of the camera is being adjusted.

FLEnEEy The gain of the camera is equivalent to a multiplier
of the intensity channel of a still image.

S aturation Indicate the saturation of the camera is being
adjusted. The saturation value 0.5 for the camera
does not modify the images coming from the
camera.

Hue Indicate the hue of the camera is being adjusted.

Note the hue of a camera is cyclic with a period of
360. That is, adding 180 is equivalent to subtracting
180. The hue value 180 for the camera is equivalent
to the hue value of 128 for a still image. If the
slider and the edit box are disabled, the camera
does not support adjustment of hue.

Use the slider to adjust the gain, saturation or hue
of the camera.

The minimal gain applicable to the present camera.

8.045

Show the current gain of the camera. A value may
also be entered directly.

16

The maximal gain applicable to the camera.
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The minimal saturation applicable to the camera.
When the saturation of a color camera is set to 0, it
delivers monochrome images.

0.5

Show the current saturation of the camera. A value
may also be entered directly. The default value 0.5
does not modify the saturation of the camera.

The maximal saturation applicable to the camera.

-180

The minimal hue applicable to the camera.

Show the current hue of the camera. A value may
also be entered directly.

180

The maximal hue applicable to the camera.

~ 0K

Push to dismiss the dialog and commit the changes
of settings to the present camera.

}‘:_ Cancel

Push to dismiss the dialog and discard any change
of settings to the present camera.

More

Use the More commands to increment, by a predefined amount, the
intensity, saturation or hue of the active image or the camera.

When the active image is an empty image and is being used to
display video streams, the commands increment the gain, saturation
and hue settings of the presently connected camera instead of the
intensity, saturation and hue of a still image.

The amount of change for each color channel may be specified by the
Increments command.

Less

Use the Less commands to decrement, by a predefined amount, the
intensity, saturation or hue of the active image or the camera.

When the active image is an empty image and is being used to
display video streams, the commands decrement the gain, saturation
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and hue settings of the presently connected camera instead of the
intensity, saturation and hue of a still image.

The amount of change for each color channel may be specified by the

Increments command.

Increments

Use the Increments command to set the amount of change made by

More and Less commands.

-~

",

Increments
Intensity 1E v Ok
Saturation 16 ¥ Cancel
Hue 16

Still Image Live Image

of a pixel is in | applicable gain

the range values is specific to

[0,255]. each model of

Values out of | camera. The

the range will | increment of gain is

be truncated. | proportional to that
of the intensity of a
still image.

S aturation 16 The sqtura_tiqn The satqra_tion of a

of a pixel isin | camera is in the

the range range [0, 1]. The

[0,255]. increment of

Values out of | saturation of the

the range will | camera is

be truncated.

proportional to that
of a still image.
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Hue 16 The hue ofa | The hue of a camera
pixel isinthe | isin the range [-
range [0,255] | 180, 180]. The

and is cyclic increment of hue of
with a period | the camera is

of 256. proportional to that
of the hue of a still
image.

Push to dismiss the dialog and
v OK commit the new settings.

Push to dismiss the dialog and
#. Cancel discard any changes.

Mirror

Use the Mirror commands to flip the active image.

When the active image window is showing the video, the command
actually flips the live images.

Rotate
Use the Rotate commands to rotate the active image.

When the active image window is showing the video, the command
actually rotates the live images.

Magnification

Use the Magnification command to synchronize calibration with
objective switching.

For correct measurement and printing, Optika™ Vision Pro needs to
know the sampling intervals and magnification of the digital image.
Horizontal sampling interval, vertical sampling interval and
magnification comprise a micrometer. Each image acquired with
Optika™ Vision Pro has a micrometer associated with it. This
micrometer is the basis of correct measurement and printing and
cannot be modified after the image has been created. Optika™ Vision
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Pro also maintains a system micrometer. When an image is being
captured, the system micrometer is duplicated and set as the
micrometer of that image.

The process that sets up the system micrometer is referred to as
calibration. In the simplest sense, calibration can be done for a single
objective and use the Magnification command to adapt to different
objectives or magnifications. A successful calibration will correctly
set up the sampling intervals and magnification for use with that
objective. When a new objective and/or some other intermediate
lenses are in place, the Magnification command records the updated
magnification and scales the sampling intervals accordingly.

L |

System Micrometer
Horz Sampling i | 4
Yert S ampling 7 Cancel
b agrification 100

The present horizontal
sampling interval, in
microns, kept in system
micrometer.

Horz Sampling

The present vertical
sampling interval, in
microns, kept in system
micrometer.

Yerk Sampling

110 The present
magnification kept in
system micrometer. The
new magnification
should be entered here.

b agrification

Push to dismiss the
v 0K dialog. The newly
entered magnification
will be accepted and the
sampling intervals will
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be scaled accordingly.

Push to dismiss the
dialog and discard any
change to system
micrometer.

¥ Cancel

Equivalent Commands
1 From Settings File

Upon startup, Optika™ Vision Pro automatically loads and applies the
system micrometer used last time. When Optika™ Vision Pro exits, it
automatically updates the settings file.

2 From Capture Control Sub-Pane

xr

400 Fluorescent w

Preset &dd

(») VideaOn (1) Video OFf

[ Auto Expozure ] [White Balance ]

+-..,_ Area AE f Area Wb

Biaz 0 = 10| Capture

Light Source Frequency

(J)50Hz (O BOHz (2 DC

[ ] Comtinuous Auto E xposure

400 = Fluorescent W

Camera presets include micrometer setting. If a preset, for example
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400 X Fluorescent, is selected, the system micrometer will be replace
by the one stored in the preset and all subsequently acquired images
will be calibrated according to the system micrometer stored in that
preset. This helps to avoid measurement errors induced by system
error of the magnification power of the objectives.

Micrometer > Calibration

Use the Micrometer > Calibration command to set up system
micrometer.

The system micrometer consists of the sampling intervals in
horizontal and vertical directions, and the magnification intended for
printing this image. In the calibration process only one of the two
sampling intervals will be calculated as modern cameras all have
square pixels. Optika™ Vision Pro derives the sampling interval from
the length of a straight line segment on the image of a calibration
slide. An image of calibration slide may be captured with Optika™
Vision Pro as illustrated below. Click on the two endpoints to specify
a line segment on the image of the calibration slide.

&l

30 40 50 60 70 80

_|||||||l||||l|l|l||||llllI|II|III|IIII|II
Micrometer Calibration
Lenath 100 v 0K
Magrification 100 S [
Linear Measurement U nit urn = Ml ricromn(z)
Square Measuremment L nit urna | ne |
£ 3
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In the Micrometer Calibration dialog, specify the length of the line, in
microns, and the intended magnification. In addition, it is also
possible to use a measurement unit other than micron.

Micrometer Calibration
Length 100 W DK
M agrification 100 e e
Lirear bMeazurement Lnit L = |l micron|z]
Square Meazurement Unit umz

Length 0l !Ente_r the length of thg line,
in microns, not counting
magnification factor.

M agrification 100 Enter'tr_le n_omlnal
magnification. The
magnification is used in
printing only where the
image appears magnified on
paper. All measurements are
done in microns and have
nothing to do with
magnifying factor.

Push to close the dialog and
OF ) .
v commit the new settings of
system micrometer.
Push to close the dialog and
». Cancel discard any change to
system micrometer.

Linear Measurement Llnit L S_peCIfy the name of th? new
linear measurement unit.

- e Specify the conversion

formula from the new unit
to micron.
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Square Meazurement Lnit umna Specify the name of the.new
square measurement unit,
which must be based on the
new linear measurement
unit.

IMPORTANT!!!

Calibration should be done on an image captured at full field of view

with no decimation.

Micrometer > Burn into Image

Use the Burn into Image command to place a graphical representation

of micrometer on the active image.

The graphical representation of the active image’s micrometer will be
placed on the overlay layer of the active image.

Micrometer > Burn into Image Options

Use the Burn into Image Options command to customize the

graphical representation of the micrometer.

-

-,

Options for Burning Micrometer into Image
Length 100 LI W Ok
Text 100 micron # Cancel
b argin Fight bid
b argin B ottam bid

Length 100 The length, in the

system’s current
measurement unit, of
the scale bar, to be
drawn on the overlay
layer of the active
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image.

Text 100 micron

The text to appear
under the scale bar.

bd argir Right b4

The distance, in pixels,
between the right side

of the scale bar and the
right side of the active

image.

b4 argin B ottom B4

The distance, in pixels,
between the bottom of
the scale bar and the
bottom of the active
image.

v 0K

Push to dismiss the
dialog and put the new
options for burning
micrometer in effect.

x Canicel

Push to dismiss the
dialog and discard any
change to options for
burning micrometer.

74

www.optikamicroscopes.com




The Enhance Menu

Flatfield Correction

Use the Flatfield Correction command to filter the active image to
make appear as if having been evenly illuminated.

The example below illustrates the process for a still image.
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It the active image window is displaying video stream from the
camera, this command calibrates the camera to correct both
illumination and optical system transmittance non-uniformity.

For best result:

1. Shoot the camera at a slowly varying white background. The field
of view should not be obstructed by any object other than the white
background.

2. Adjust the illumination, lens aperture or camera exposure time so
that the image is as bright as possible but not exceeding its dynamic
range.

3. Perform white balance to remove the apparent color aberrations.
The temperature should be reset to pure white.

Flatfield Correction Options

Use the Flatfield Correction Options command to customize the filter
employed in Flatfield Correction.

COptions for Flat-Field Correction
Homogenous B adius £ v 0K
¥ Cancel
The support of the
Homogenowus B adius £} Gaussian filter that will

be used to detect
illumination distribution.
Intuitively, it is the
radius, in pixels, of the
biggest circle within
which illumination
remains even. The
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default value 31 should
work well in most cases.
A greater value may be
specified if the
illumination is flatter. A
smaller value may be
specified if the
illumination varies more
abruptly.

Push to dismiss the
v DK dialog and update the
parameter for use with
Flatfield Correction.

Push to dismiss the

. Cancel dialog and keep the
original parameter of
Flatfield Correction.
Denoise

Use the Denoise command to suppress noise in the active image.

The example below illustrates the process.
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Remove Bad Pixels

Use the Remove Bad Pixels command to detect and make up
malfunctioning pixels.

The example below illustrates the process. The first image is captured
with a camera having defective pixels. The second image is result of
the operation. The third image is the result of the command executed
twice.
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Unsharp

Use the Unsharp command to do the generalized unsharp mask
filtering for the active image.

The example below illustrates the process.
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Unsharp Options

Use the Unsharp Options command to set up parameters for Unsharp.

Unsharp masking is a traditional film compositing technique used to
sharpen edges in and improve the contrast of an image. Optika™
Vision Pro generalizes this technique to make it more powerful. The
generalized unsharp masking, also known as latitude reduction, uses a
Gaussian filter to separate an image into two images, one is the low-
frequency part, called background image, and the other is the high-
frequency part, called contrast image. The background image,
representing the latitude or dynamic range of the image, may be
reduced by multiplying a coefficient smaller than unity. Latitude
reduction actually improves the contrast without enhancing noise. If
the image is free of noise, the contrast image may also be multiplied
by a coefficient greater than unity to augment contrast
straightforwardly. This process is referred to as high boost. Finally
there is a visual psychology factor to be considered. Boosted contrast
in dark areas of an image may be interpreted as noise. To make the
processed image appear natural, the intensities of background image
pixels could be used as weights when the contrast image is being
added back to the background image to form the output image of the
latitude reduction operation. The process of adding contrast image to
background image is called back-projection.
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-~

Cptions for Unsharp

"

b azk Badius

Latitude R eduction

High B oozt

Combine

11

0.5

v  OK
¥ Cancel

b azk Badius

1

The support of the
Gaussian filter to
separate the active image
into background and
contrast.

Latitude Reduchion

0.5

The coefficient by which
the background image
will be multiplied. 0.5
corresponds to latitude
reduction by 1 bit. 0.25
corresponds to latitude
reduction by 2 bits. Any
value may be entered
here. However, if a
number greater than 1 is
given, the contrast of the
image will be decreased.

High Boost

The coefficient by which
the contrast image will
be multiplied. Any value
may be entered here.
However, if a number
smaller than 1 is given,
the image will be
smoothed.

81

www.optikamicroscopes.com




Specify how the
background image and
contrast image are
combined. Valid values
are in the range [0, 1]. If
0 is entered, the
background image and
the contrast image will
be simply added. If 1 is
entered, only the
brightest pixels of the
background image will
be modified by adding
corresponding pixels
from the contrast image.
The parameter
determines the
dependency of back-
projection on
background image.

Combine 0

Push to dismiss the
VDK dialog and keep the
parameters for Unsharp.

Push to dismiss the
X Cancel dialog and discard any
change to parameters for
Unsharp.

Max Contrast

Use the Max Contrast command to linearly scale the intensities of the
active image so that they span the whole dynamic range.

The following two images, together with their histograms, illustrate
the process.
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Histogram || [Histogram 9

Sketch

Use the Sketch to generate a pencil drawing from the active image.
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The example below illustrates the process.

Adaptive Edge Emphasis

Use the Adaptive Edge Emphasis to enhance edges in the active
image.

The example below illustrates the process.
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Equalization

Use the Equalization command to manipulate the histogram of the
active image to make it as flat as possible.

The following two images, together with their histograms, illustrate
the process.
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Histogram || [Histogram 9

Amplitude Depletion

Use the Amplitude Depletion command to extract the texture of the
active image.
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The example below illustrates the process.

Darkfield Simulation

Use the Darkfield Simulation command to generate a darkfield
representation of a brightfield image.

The example below illustrates the process.
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Photometric Transform

Use the Photometric Transform commands to generate a grayscale or
inverted representation of the active image.

The Monochrome command removes color information from the
active image and leaves only intensity information, as shown below.
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The Negative command reverses the lookup table of the active image
to produce an image that is complementary in color with the original
image, as shown below.
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Spherical Aberration Correction

Use the Spherical Aberration Correction to reduce the haze over the
active image due to spherical aberration of the optical system.

The example below illustrates the process.
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Spherical Aberration Correction Options

Use the Spherical Aberration Correction Options command to
specify to what degree the spherical aberration will be corrected.

5 |

Cptions for Spherical Aberration Correction ﬁ
51 v 0K
J ¥ Cancel
tare Clarity Mo Effect [100] Less Moize
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There is only one parameter to control the spherical aberration
correction. Acceptable values for this parameter are in the range [1,
200]. Setting the parameter to a number less than 100 will cause haze
to be removed from the image. Setting the parameter to a number
greater than 100 will smooth the image.
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The Measure Menu

The measuring operations of Optika™ Vision Pro are the digital
version of the more traditional planimetry with microscopes. A
measuring operation of Optika™ Vision Pro generates one, two or
three pieces of output information. Each operation results at least in
some graphics on the overlay layer of the image. Most operations
also create textual annotation objects describing the quantitative
outcome of the measuring operations, and entries in the table of the
auxiliary window Measurement holding the quantities.

An image of Optika™ Vision Pro can have many layers. At the bottom
is the pictorial layer, which is similar to an ordinary image consisting
of pixels. Above the pictorial layer is the mask layer. The mask layer
is useful to image segmentation and mathematical morphology. The
next layer is the overlay. The micrometer, when burned into image,
will be placed on this layer. The graphics generated by measurement
operations will also be placed on the overlay layer. An annotation
object is a temporary layer on top of all permanent layers. When
annotation objects are being burned into image, they will be placed
on the pictorial layer. Those annotation objects that have not yet been
burned when the image is closed will be discarded.

The graphical output of a measuring operation is placed on overlay
layer. The textual output of a measuring operation is a text box,
exactly as that can be created manually with annotation commands
except the textual description of measurement result is generated by
Optika™ Vision Pro. The quantitative output of a measuring operation
IS one or more new entries in the auxiliary window Measurement.
Each entry or record has three fields, the first field is the name of the
command that has generated the entry, the second field is the
parameter that is being measured, and the third field is the numerical
result of the measurement operation.

If some measurement has been done for an image, the measurement
results will also be saved when the image is stored to the database.
When the image is again loaded from the database, the previous
measurement results will also be loaded.
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Reset

Use the Reset command to clear overlay layer and measurement
result of the active image.

Abort

Use the Abort command to terminate the present measuring operation.
Equivalent command

Right button double click on the active image being measured.

Grid

Use the Grid commands to draw a lattice on the active image.

The Grid > Line draws a rectangular lattice on the overlay layer of
the active image.

The Grid > Circle draws co-centric circles on the overlay layer of the
active image.

Grid Options

Use the Grid Options command to specify how grids are to be drawn.
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Cptions for Gnd
R ectangular v K
S pacing b4
X Cancel

Cocentric

R adiuz 32

R adiuz Increment 32

: E4 The distance between
Spacing neighboring parallel lines of

the rectangular grid.

. 1z The radius of the innermost
Radius circle of the co-centric
circular grid.

The difference of radius of
neighboring circles of the
co-centric circular grid.

Fadiuz Increment 32

Push to close the dialog and
v K keep the settings.

Push to close the dialog and
discard any change to grid
options.

¥ Cancel

Light Density

Use the Light Density command to profile the intensity distribution of
a row of pixels.

Push down the left button of the mouse to start profiling. A horizontal

line will be drawn, passing through the position of mouse cursor. The
intensity distribution of those pixels of the active image on this line
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will be profiled. This line also stands for the half of the dynamic
range, i.e. 128. Another line, being drawn below, stands for 0. The
curve, drawn over the image, stands for the intensities of the pixels.

Move the mouse, while keeping the left button of the mouse pressed,
to preview other rows of pixels. Release the left button of the mouse
to finalize the profiling.

Repeat the above procedure for more profiles.

The Light Density command generates graphical output only.

The examples below illustrate the process.
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Counting

Use the Counting command to simulate a tally machine.

Click to count. A temporary mark appears with each click. Right
button double click to finish counting. The visited locations will be
marked with serial numbers. These graphics appear on the overlay
layer of the image.

The Counting command also generates an entry in the auxiliary
window Measurement.

The example below illustrates the process.
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Angle

Use the Angle command to measure angles.

Click to specify three controlling(Points. The angle made by the line
passing through the 1% and the 2™ point, and the line passing the 2™
and 3" point, will be measured.

The Angle command, if successfully executed, generates three types
of output. The angle will be shown as graphics on the overlay layer.
A short description of the angle will appear in a text box annotation
object over the image. The auxiliary window Measurement will also
have a new entry added.

The following example illustrates the process.
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Polyline

Use the Polyline command to measure the lengths of connected line
segments.

Click to specify endpoints of the connected line segment. Right
button double click to signify that all endpoints have been added and
the Polyline command has been completed.

The total and average length of the line segments will be calculated.
The line segments will appear on the overlay layer of the active
image. A short description of the total and average length of the line
segments will appear in a text box annotation object. Two entries will
be appended to the auxiliary window Measurement. One entry is the
total length of the line segments. The other entry is the average length
of the line segments.

The example below illustrates the process.
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Circle from 3 Points

Use the Circle from 3 Points command to measure the radius of a
circle.

Click to specify three points. If these points are not collinear, a circle
can be unique determined which passes through the three points. The
circle will appear on the overlay layer of the image. A short text
describing the quantity of its radius will appear in a text box
annotation object. A new entry will be made to the auxiliary window
Measurement recording the value of the radius.

Repeat the above procedure to measure more circles.

The example below illustrates the process.
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Area Perimeter

Use the Area Perimeter command to measure the area and perimeter
of a closed shape.

The closed shape is created by freehand drawing, i.e. moving the
mouse while pressing down left mouse button. Release the left mouse
button to signify the end of drawing. The starting point, i.e. where left
button is pressed, and the ending point, i.e. where the left button is
released, will be connected automatically by a straight line to close
the shape.

The drawing will be put on the overlay layer of the image. A short
text describing the measured area and perimeter will appear in a text
box annotation object. Two entries will be appended to the auxiliary
window Measurement. One entry is the area, the other is perimeter.

The example below illustrates the process.
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Caliper

Use the Caliper command to measure the distance between two
points or two parallel lines.

Click to specify two points. After the first click a rubber band with
two perpendicular legs is being drawn to connect the first point and
the current mouse position. Use the legs to align with parallel lines.
The second click ends the measurement.

The caliper will be placed on the overlay layer of the image. A short
description showing the distance will appear in a text box annotation
object. A new entry will be appended to the auxiliary window
Measurement to hold the value of the distance.

The example below illustrates the process.
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Polygon

Use the Polygon command to measure the area and perimeter of a
polygon.

Click to specify the vertices of the polygon. After the last vertex has
been specified, double-click right button to start (and to complete) the
measurement.

The polygon will be put on the overlay layer of the image. A short
text describing the measured area and perimeter will appear in a text
box annotation object. Two entries will be appended to the auxiliary
window Measurement. One entry is the area, the other is perimeter.

Measurement Options

Use the Measurement Options command to specify if and how the
annotation will be generated for measurement.

This command brings up the following dialog.
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= =

Measure Options
Generate Annotation v Ok
Murmber of Decimal Places 2 P

Frefis
Bngle | A=

Palyline | T= T atal Length

b= Length Average
Circle from 2 Pointz (A= R adiuz
frea Perimeter | 5= Brea
(Falygon)

P= Perimeter

Caliper D=

The text annotation may or may not be generated. Check “Generate
Annotation” to create text overlays for measurement commands. If a
measurement command outputs more than one quantity, the
annotation overly of either or both may be turned on or off. Each
annotation item starts with a lead text and followed the measured
quantity and closed by the measurement unit specified in calibration.
The lead text may be freely changed during this dialog session.

Push “Properties” button to specify the appearance of text overlays.
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The Annotation Menu

An image of Optika™ Vision Pro may have temporary layers called
annotation layers. Each annotation layer consists of an annotation
object. An annotation object is a vector graphics object that can be
moved, resized or edited without loosing resolution. Annotation
layers exist only when an image is being annotated by Optika™
Vision Pro. Annotation objects may be burned into the image, where
the pixels of the pictorial layer of the image are modified to represent
the vector graphics of the annotation objects. Annotation objects that
have not been burned into image when the image is saved to disk or
cached in Field Group will be deleted. The process of burning an
annotation object includes deleting that temporal layer. Annotation
layers are topmost layers of an image of Optika™ Vision Pro and may
obscure pictorial and overlay layers.

Annotation is possible only when Optika™ Vision Pro is in annotating
mode. To enter the annotating mode, choose Annotate > Enable. To
leave the annotating mode, choose that menu item again. In
annotating mode, those measurement commands that involves
extended mouse actions will be disabled. The hand tool for image pan
and scroll and the micrometer calibration are also disabled in
annotating mode.

One or more annotation objects can be selected. Click to select an
object in the annotating mode. Shift + Click to select an additional
object. To select all the annotation objects, press Ctrl + A. To
deselect all the annotation objects, double-click anywhere that is not
occupied by an annotation object.

Selected objects can be moved together. To move selected objects,
drag any one of them. Selected objects can also be cloned. To clone
selected objects, click any one of them while pressing down the Ctrl
key.

When a selected object is the only selected object, it may be resized.
To resize an annotation object, drag its resizing handles. An
annotation object can have as many as nine resizing handles located
on the bounding rectangle of the annotation object. Resizing handles
usually reside at the four corners or the center of line segments. To
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detect a resizing handle, hover the mouse over the bounding rectangle
and wait for the change of cursor. If a resizing cursor appears, it
means the mouse is over a resizing handle. Note the bounding
rectangle will not appear until the object is selected.

Each annotation object has a set of properties associated with it. The

properties may be edited through popup dialogs. To change the
properties of an annotation object, double-click that object.

Enable

Use the Enable command to toggle annotating mode.

In the annotating mode of Optika™ Vision Pro, all mouse actions over
the active image, except those for annotation, are disabled.

Line

Use the Line command to add line objects.

Each line object is defined by two endpoints. Press left mouse button
to specify one of the endpoints. Move the mouse to the other
endpoint, while keeping the left mouse button pressed, to draw the
line. Release the left mouse button to complete the line drawing.

The above procedure may be repeated to create more lines.

A line object has two resizing handles, located at the two endpoints.
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Properties

araphic= |

Line

Color m

St_'.-'lE-' Ii LI "l"I

Size |2 = [ ] Round Pen
Fill
Calor I -I Trangparent
Ao
Trailer Style -~| Size
Head Style | Size
aF. | | Cancel

Color m

below.

Show the color to draw the line.
Click to pick up a new color from
the popup palette as illustrated
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fukoratic

Mare Caolars. ..

Push Automatic to specify the
light gray color. Push More
Colors to bring up the Windows
Color Picker Dialog for more and
customized colors.

Show the width of line. A new
value may be entered directly. Or
use the spin buttons to adjust the
setting.

St_'.-"E-' |+++i 1r|

Show the style of the line. Click
to pick up a new style from the
popup style selector as illustrated
below.

+F+FFFFEFFEEE

- R E

-

- F 4 .

+ + + + + =

- F . + .=

[ ] Round Pen

If checked, the endpoints of the
line will be drawn as solid balls.
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Rectangle

Use the Rectangle command to add rectangle objects.

Each rectangle is specified by two diagonal vertices. Press down left
mouse button to specify one vertex. Move the mouse to the other
vertex while keeping left mouse button pressed to draw the rectangle.
Release left mouse button to complete the creation of this rectangle.

Repeat the procedure above to add more rectangle objects.

A rectangle object has eight resizing handles as illustrated below.
Drag the handles at the four corners to adjust width and height of the
rectangle simultaneously. Drag the other handles to adjust width or
height but not both. Drag anywhere else within the rectangle to move
the rectangle object.

- = |
] n
L = - |

Double-click a rectangle to edit its properties. As illustrated below,
the properties of a rectangle object consist of those properties of those
four lines that make up the rectangle and the properties that specify
how the interior of the rectangle is to be painted.
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[ ]

Properties
araphic= |
Lire
Calor WEI Style |— - |
Size |1 % [RoundPen
Fill

Calor | - | [ ] Transparent

Arrow

Trailer Style | | Size
Head Style | | Size

| aF. | | Cancel

For line properties, please refer to the Line command. The painting of
the interior of a rectangle is defined by the Fill sector of the above
dialog.

Fill

Color | - | [] Tranzparent

Show the present color to fill the
Color | = interior of the rectangle. Click to
pick up a new color as shown
below.
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fukoratic

Mare Caolars. ..

Click Automatic to choose gray.
Click More Colors to bring up
the standard Windows Color
Picker Dialog where a new color
may be defined.

If checked, the Color property
will be ignored and the interior of
the rectangle will not be painted
to allow the otherwise obscured
objects or pixels to be visible.

[ ] Tranzparent

Round Rectangle

Use the Round Rectangle command to add round rectangle objects.

A round rectangle is similar to a rectangle except that its corners are
made up of arcs. The creation, moving, resizing and editing of a
round rectangle is similar to those of a rectangle except for the
following.

A round rectangle has nine resizing handles. The handle within the

round rectangle, as shown below, is used to adjust the roundness of
the corners.
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A round rectangle has limited line properties. The line styles other
than the solid cannot be specified for a round rectangle.

Ellipse

Use the Ellipse command to add ellipse objects.
An ellipse is fully specified by its minimum bounding rectangle. The
creation of an ellipse object is identical to that of its minimum

bounding rectangle, as illustrated below, although the rectangle is not
visible when the ellipse is not selected.

An ellipse is moved, resized in the same way as a rectangle object.
The properties of an ellipse are identical to those of a round rectangle,
i.e. only solid line style is applicable.

Polygon

Use the Polygon command to add polygon objects.

There are two ways to create a polygon object, by clicks and by
freehand drawing.

By Clicks
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A polygon is specified by its vertices. Click to add a new vertex.
Double-click to add the last vertex.

By Freehand Drawing

Press down the left mouse button to start drawing. Move the mouse
while keeping left button pressed to draw a polygon. Double-click to
finish drawing.

If a polygon has been created by clicks, each vertex is a resizing
handle. If a polygon has been created by freehand drawing, each
point on the drawing is a resizing handle. See below for an
illustration. The polygon on the left is created by clicks; the one on
the right is created by freehand drawing.

A polygon has an identical set of properties to that of an ellipse.

Arrow

Use the Arrow command to add arrow objects.

An arrow is made up of an arrow head, an arrow trailer, and a line
connecting the arrow head and trailer. The arrow head and arrow
trailer are shapes consisting of enclosing lines and interiors. The lines
enclosing arrow head and arrow trailer, and the line connecting the
arrow head and arrow trailer, have full line properties associated with
them. The interiors of arrow head and arrow trailer have full fill
properties associated with them.
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An arrow is created, moved and resized in the same way as a line.
The properties of an arrow include, besides line and fill properties,
the shape and size of arrow head and arrow trailer as shown below.

- =

Properties
araphic= |
Lire
Calor -EI Style |- + - 1r|
Size |3 % [RoundPen
Fill

Coor =] @Tianspaent

Arrow

Trailer Style | — 1r| Size | g {:}
Head Style | p ~r| Size 5 |3

| aF. | | Cancel

Arrony

Trailer Style - v SizE |3 E:}

Head Style =) ~| Size f =

Click to pick up a new style of the arrow head.
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The style of the arrow trailer is set in a similar way. The shapes of
arrow trailer are mirrors of those of arrow head.

Use the spin button to adjust the size of arrow head or arrow trailer.
The size is defined as diameter of the bounding circle of the shape
measured in pixels.

Text
Use the Text command to add text box objects.

Click to add a text box object. Unlike other annotation commands the

property dialog appear immediately upon the creation of a text box
object, as illustrated below.
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Properties

Tent | Graphics |

zee here far comments

Barder Ellipze

Alignment | |z

k.

Cancel

Push to open
the standard
Windows Font
Dialog where a
font, including
its style, size,
and effects,
may be
specified for
the text in the
annotation
object.

zee here for comments

Enter the text
for the
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annotation
object.

: Show how the
Border | Ellipse ! | bounding
rectangle of the
text appears.
Click the drop
list to specify
whether the
bounding
rectangle is to
be displayed
straight as a
rectangle, or a
round
rectangle, or an
ellipse, or not
to be displayed
at all.

Show how the
textis
positioned in
the bounding
rectangle. Click
the drop list to
specify whether
the text is to be
left justified,
right justified,
or to be placed
in the center.

Alignment | | oft o

If the bounding rectangle is to be shown, the line and fill properties
apply to the bounding rectangle. If the bounding rectangle is to be
shown as rectangle, full line properties apply. If the bounding
rectangle is to be shown as round rectangle or ellipse, line style is
forced to be solid and the other line style settings will be ignored.

External
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Use the External command to insert an OLE object.

This command opens the standard Windows Insert Object Dialog as
shown below. All servers currently installed on the system are listed
where an object may be created anew or from a file.

f = o

Insert Object @

Object Tupe: 0Ok
{(*) Create Mew Microgoft Equation 3.0 s
Microgzoft Graph Chart

3 Mizrozaft Office Excel Chart
O Create fiom Fike Microzaoft Office Excel Wark sheet
Microgsoft PowerPoint Prezentation
Mizrozaft PowerPaint Slide [ Display As |
Mizrozaft “Word Docurment =Eplay Az lcan
Mizrozaft “Word Picture il

Fezult
Inzerts a new ddobe Acrobat Document object

3 .
into pour document,

Select

Use the Select command to select one or more annotation objects.
Click to select an annotation object. Shift + Click to select additional
objects. It is also possible in this mode to draw a rectangle to select
all objects covered by the rectangle.

Click anywhere within the active image window that is not occupied
by any annotation object to deselect all objects.

Select All

Use the Select All command to select all annotation objects.
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Delete

Use the Delete command to delete selected annotation objects.

Properties

Use the Properties command to edit the properties of a selected
object.

Move to Uppermost

Use the Move to Uppermost command to make the selected object the
topmost layer.

Move to Lowermost

Use the Move to Lowermost command to make the selected object the
bottommost layer.

Move Up

Use the Move Up command to move the selected object one layer
above.

Move Down

Use the Move Down command to move the selected object one layer
down.

Burn into Image

Use the Burn into Image command to create a pixel representation of
all the annotation objects on the pictorial layer and delete all the
annotation objects.
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Annotation objects are temporary and cannot be saved into a file.
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The Window Menu

Cascade

Use the Cascade command to make all image windows the same size
and stacked from top left to bottom right of the main window.

Tile Horizontally

Use the Tile Horizontally command to make all image windows
aligned edge to edge horizontally and the same size if possible.

Tile Vertically

Use the Tile Vertically command to make all image windows aligned
edge to edge vertically and the same size if possible.

Arrange lcon

Use the Arrange Icon command to align the icons of image windows
at the bottom of the main window.
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The Help Menu

Settings

Use the Settings command to tune the performance of Optika™ Vision
Pro.

Settings
Mumber of Fields 3 v OK
Freallocated Memary 300 . Cancel
Mumber af Unda Steps B
Screen Gamma 100
FMOTE : Effective After Restart Thiz Program |

q The number
of thumbnails
in Field
Group.

Humber of Fields

The size of
the memory,
in MB, that
has been
allocated to
Field Group.

Preallocated Mernory 200

E The
maximum
length of
processing
history for
each image.

Murmber of Undo Steps

100 The Gamma
of computer
screen, in

Screen Famma
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hundredth.

Push to
dismiss the
dialog and to
apply the
settings when
Optika™
Vision Pro
runs again.

¥ Cancel

Push to
dismiss the
dialog and not
to change any
setting.

Manual

Use the Manual command to open User’s Guide.

Online Help

Use the Online Help to connect to Optika™ Vision Pro website.

About Optika Vision Pro

Use the About command to read copyright notice and version

information.
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Section 3 Other Commands

This section details the commands that are not accessible from menu.
Specifically, the Optika™ cameras and built-in database are most
conveniently controlled from Control Panel and Database Window.

Imaging Control

The camera presently connected to Optika™ Vision Pro, and the
whole image acquisition process, can be fully controlled from within
the Imaging Control Pane of Control Panel. Image acquisition will be
based on the current camera settings and capture options which are
configured by the seven sub-panes of the Imaging Control Pane
described in detail below.

Camera settings refer to those parameters that are necessary to put the
camera into a specific state. Capture options refers to what Optika™
Vision Pro will do to the frames grabbed from video stream of the
camera, including calibration for purpose of measurement and
printing. In fact, system micrometer has to be properly scaled before
applying to the newly formed image, according to the decimation
factor specified in capture options. The contents of camera settings,
capture options and calibration information are listed below.

Camera Exposure

Settings Gain

Gamma

Saturation

Hue

Brightness

Contrast

White Balance

Rotation

Flip

Light Source
Temperature

Capture Frame
Options Averaging
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Decimation

Destination

Where to store the acquired
images. It can be Field Group,
disk files, or both. A new image
window may also be created to
hold a newly acquired image.

File Name

The path of the file that may be
used to store a newly acquired
image.

Capture Full
Field of View

Optika™ Vision Pro may be
directed to exploit the full pixel
array of the camera for the image
acquisition, or just to grab a
frame from current video stream,
which may be sub-sampled or
only part of the field of view.

Preview
Captured Image

A new image window may be
created to hold a copy of the just
acquired image.

Verify File
Name on
Capture

Show a File Save As dialog box
for each acquired image that is to
be stored to a file. This option
may be used to prevent
overwriting an existing file or to
convert the image to another
format.

Auto Increment

Optika™ Vision Pro may be

File Name directed to name the files
automatically to store the
acquired images. It does so by
appending a serial number to the
initially specified file name.

Calibration Sampling
Information interval in
(Micrometer) | horizontal

direction

Sampling

interval in

vertical

direction

Magnification
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Capture Control

400 Fluorescent W

Prezet Add

(») VideoOn () Videa Off

[ Auto Expozure ] [‘-.-'-.-’hite B alance ]

“a AreadE P Area'wB

Biaz 0 = 1@ Captue

>

Light Source Frequency

(JBOHz (O EIHz (S DC

[ ] Comtinuous Auta E xposure

Presets

*r

A preset consists of a complete set of parameters for controlling the
camera, a subset of capture options and image calibration information

as detailed below.

Camera Settings Exposure

Gain

Gamma

Saturation

Hue

Brightness

Contrast

White Balance

Rotation

Flip

www.optikamicroscopes.com
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Light Source Temperature
Capture Options Frame Averaging
Decimation
Calibration Information Sampling Intervals
(Micrometer) Magnification

Optika™ Vision Pro maintains a list of presets. A preset is identified
by a name and by its position in the list if the name is not unique. A
present name is a single line of text, which is entered when a preset is
created and added to the preset list, as shown below.

o~ 1

Preset Hame

400 Fluorescent w  OK

}( Cancel

Show the name of the preset
that is currently applied. Click
to apply another preset.

A special preset, named
“Default”, will be created by
Optika™ Vision Pro whenever
a new camera is attached. It is
always the first in the preset
list and contains factory
settings.

400 ¥ Fluorescent e

Push to remove the current

preset from the preset list.
Note that the present camera
settings, capture options and
system micrometer will not be
affected. Just that the preset is
deleted from the list.

& dd Push to create a new preset
and add it to the preset list.
The name of the preset is
specified in the dialog above.
The content of the preset is
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derived from the current
camera settings, capture
options and system
micrometer.

Most Important Camera Settings

Color reproduction and overall brightness dictate image quality. The
color reproduction of a camera is controlled by gains applied to color
channels of the camera. It is most convenient to let Optika™ Vision
Pro determine the necessary gains from live images, a process known
as white balance. White balance may be based on either the whole
live image that is currently being displayed or a small area therein.
Optika™ Vision Pro uses the term White Balance for the operation
based on the whole image and Area-Based White Balance (Area WB)
for the operation based on a small area within the live image. Much
like white balance, an optimal exposure time may also be determined
by Optika™ Vision Pro. Auto Exposure refers to the operation that
Optika™ Vision Pro determines and sets an optimal exposure time
based on the visible portion of the live images being displayed.

| “ihite Balance Push to perform white balance
based on the visible portion of
the live image.

j" Ares W Push to perform white balance

based on a small rectangle within
the visible portion of the live
image. The operation is
completed by a click on the live
image, which specified the center
of the rectangle on which the
white balance will be based. The
width and height of the rectangle
is the smallest region of interest
that is supported by the camera.

Push to have exposure time
determined and set automatically
based on the visible portion of
live image. The other sub-panes
will be updated to synchronize

[ Auto Expozure ]
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with the new exposure time.

“a, MreaAE

Push to perform auto exposure
based on a small rectangle within
the visible portion of the live
image. The  operation is
completed by a click on the live
image, which specified the center
of the rectangle on which the
auto exposure will be based. The
width and height of the rectangle
is the smallest region of interest
that is supported by the camera.

Biaz 0O —

Specify a bias for auto exposure.
If the previous auto exposure
operation produced too bright
images, specify a smaller value.
If the previous auto exposure
operation produced too dark
images, specify a greater value.
Valid bias is any integer in the
range [-30, 30].

[ ] Continuous Auta Exposure

Check to allow Optika Vision
Pro manage the exposure time of
the camera.

Light Source Frequency

() 80Hz () BOHz

® DC

Specify the frequency of the light
source to avoid flickers.

Preview and Capture

(») ‘Video On

Push to turn on video preview. Optika™ Vision
Pro uses an empty image window to display live
images. At any time at most one of those empty
image windows may be streaming video. If there
are multiple empty image windows and none is
being used for streaming video, this command
randomly picks up one for video preview. If a
window is already streaming video, this command
has no effect. If there is currently no empty image
window, this command creates one and displays

129

www.optikamicroscopes.com




live images therein.

(1) Video Off

Push to turn off video preview, if there is
currently a window displaying live images.

A€, Capture

Push to acquire an image based on the current

camera settings and capture options. The acquired
image will be automatically calibrated according

to system micrometer and present decimation
factor.

www.optikamicroscopes.com
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Time Lapse

Optika™ Vision Pro is able to acquire a sequence of images
automatically, an operation referred to as time lapse capture. Two
parameters have to be specified to start a time lapse capture, one is
the time interval, referred to as frequency, at which the images will
be acquired, and the other is the span, referred to as duration, of the
time which is needed for the whole sequence of images to be
captured. An image of the sequence will be acquired according to the
camera settings and capture options at the time when the acquisition
action occurs. Each captured image will also be calibrated according
to the system micrometer and decimation factor at the time when the
acquisition action occurs. Note that the time lapse capture initiated
from this sub-pane will be carried out in background. It is free to do
whatever is possible with Optika™ Vision Pro during the time lapse
capture.

e

Interval 1 [z]

Druration 100 [=]

1/11 completed. 11z to go.

Imterval 1 3] Time interval, in seconds.

Diuration 10/ =) Time duration, in seconds.

Push to initiate time lapse capture.
Video preview might be necessary if
not to capture full field of view.

Push to abort the time lapse capture.

1411 completed. 11= to go. | The progress of the time lapse capture.
Both the number of captured images
and the estimated time, in seconds,
needed to complete the task, are given.
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Camera Control

The exposure, global gain and Gamma of the camera may be set from
this sub-pane.

E zpozure [mz)
01z 132.05 133
PET
1 2.045 16
armma
0.01 1 100
[ ] &pply Flatfield Comrection
Exposzure [mz) Use the slider to adjust the exposure
time of the camera. The exposure is
J in milliseconds and is adjusted

logarithmically.

012 The minimal exposure time
' allowable for the camera.

Show the current exposure time of
132.05
the camera. A new value may also be
entered directly. The exposure is in

milliseconds.
1723 The maximal exposure time
allowable for the camera.
Gain Use the slider to adjust the global
gain of the camera. The global gain
\j of a camera is the factor multiplied to
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the intensity channel of each raw
pixel.

1 The minimal gain allowable for the
camera.

Show the current gain. A new value
a.046 :
may also be entered directly.

16 The maximal gain allowable for the
camera.

Garnma Use the slider to adjust the Gamma
\j of the camera.

0. Minimal Gamma allowable for the
camera.

1 Show the current Gamma of the
camera. A new value may also be
entered directly.

100 Maximal Gamma allowable for the
camera.

|:| Apply Flatfield Correction Turn on or off flatfield correction for
live images.
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Image Orientation

Depending on the model of the camera being connected, the live
image may be rotated or flipped. The image orientation, i.e. rotation
and flip, may be controlled from this sub-pane.

»

Huotate [degree clockwize]

Flip
[ JHorizontal [ ] ¥ertical

Hotate [degree clockwize] Flip
[ JHorizontal [ ] Vertical

Show the angle by which the live | Show whether horizontal or
image is currently being rotated. | vertical or both flips have been
Click to specify a new value. applied to the live image. Click
to set or reset a flip state.
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Capture Options

Averaging
®1 0Oz 0©4 0Os8
Subzarmpling
®1 0z Q3 O4
To
{ ) File (%) Field Group () Bath
C:ADocurnentz and S ettings* [:]
Prewview Captured Image
[ ]|Werify File Mame on Capture
[ ] &uto Increment File Mame
Extended Exposure [z
Enable Feszet Gain
Minimum 0126333
Current  154.339
taximum 3880396
Ayeraging Select the number of frames
®1 O2 O4 Of to be averaged. If 1 is

selected, no frame
averaging will be
performed. If 2 is selected,
two successive frames will
be summed and then
divided by two to create the
intermediate image that is
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the input to subsequent
post-capture processing. 4
and 8 are similarly defined.

Frame averaging reduces
noise. If n frames are
averaged, the energy of the
noise will be 1/n of its
original level.

Frame averaging IS
performed  only  when
capturing full field of view.

Subzampling

®1 02 O3 0O

Sub-Sample the output
image of the Averaging
process. If 1 is selected, no
sub-sampling will be done.
If 2 is selected, the number
of columns and number of
rows of the image will be
reduced by a factor of two
by merging every two
consecutive columns and
rows. 3 and 4 are similarly
defined.

Decimation reduces the
noise level much like
averaging. The way Optika
™Vision Pro performs
decimation also helps to
avoid aliasing.

Decimation is performed
only when capturing full
field of view.

To
( )File (%) Field Group ) Bath

Select a destination of the
acquired images. If File is
selected, the image will be
stored to disk under that file
path specified below. If
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Field Group is selected, the
image will be appended to
Field Group if there is still
room. If Both is selected,
the image will be stored as a
file on disk and also
appended to Field Group.

C:A\Documentz and Settings*

Show the file name to be
used when the captured
image is to store on disk. A
new file name may be
entered directly.

-]

Push to bring out a File
Save As dialog to specify
the file name to be used
when the captured image is
to store on disk.

Capture full hield of view

If checked, the image of the
full field view will be
captured regardless of the
preview state. If unchecked,
only the image that is being
previewed will be captured.
This can be a sub-region of
the full field of view, or
lower-resolution image
which Optika™ Vision Pro is
using for display purpose.

[ ] Preview captured image

If checked, a new image
window will be created to
load a copy of the acquired
image.

[ ]Werify file name on capture

If checked and the acquired
Image is to store in a file, a
File Save As dialog will be
brought up after each image
is acquired. The file name
contained in the dialog is
initially set to the
previously specified file
name such as
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“e:\report\specimen.jpg”.
However, it is free to
change the file name, or
instruct Optika™ Vision Pro
not to save this image to
disk at all.

[ ] swito increment file narne

If checked and the captured
image is to store in a file,
the file name will be
changed by Optika™ Vision
Pro after the current image
has been saved. The new
file name will be used for
the next captured image.
The new file name will have
a integer appended to the
original text and this integer
will be incremented by one
each time the new file name
is generated by Optika™
Vision Pro.

Extended E xposure [mz]

Enable Fezet Gain
Minimum 0126333

Curent 154383

b axirum 332098

The extended exposure
mode is available to CCD
cameras only. If “Enable” is
checked, the following
image captures will be
based on the exposure time
shown in the edit box. This
exposure time may be
entered directly, or let
Optika Vision Pro calculate
automatically by pushing
“Auto” button. The
calculated value is simply
the preview exposure time
multiplied by gain. Note
that the gain is still effective
for still imaging. To take
advantage of the long
exposure capability of CCD
cameras and for the best
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image quality, gain may be
set to unity and reset to the
original value after the
acquisition. This procedure
may be automated by
checking “Reset Gain”.
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Camera Control Extended

The saturation, hue, brightness and contrast of the camera may be
controlled from this sub-pane. Note that adjusting saturation of a
camera means to modify the saturation of each pixel in each frame of
the video stream from that camera by the specified amount. Note also
that the range of saturation of a camera must be scaled to match that
of a pixel, which is always [0, 255]. The same is true for hue.
Brightness and contrast are purely camera-specific. All these
parameters of the camera are adjusted independently of the others,
that is, each type of adjustment is separately applied to the raw video
frames of the camera.

S aturation
0 05 1
Caolor Gainz
= v
1 3.9 g
)
1 2 a
" —
1 3 a
S aturation Use the slider to adjust the
J saturation of the camera.

The minimal saturation allowable
for the camera. If set to 0, a color
camera appears to be delivering
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monochrome images. This is
equivalent to subtracting 256
from the saturation of each pixel
in a still image.

0.5

Show the current saturation of
the camera. A new value may
also be entered here. The default
setting is 0.5 where the saturation
of the raw image is not modified.

The maximal saturation
allowable for the camera. This is
equivalent to adding 256 to the
saturation of each pixel in a still
image.

Use the slider to adjust the green
gain of the camera. The same is
for the other two colors.

The minimal color gain allowed.

The current green gain.

The maximal color gain allowed.
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Database

The management of the built-in database, and the interaction of the
active image and the database, may be carried out from the auxiliary
window Database.

Database X
* = | Searchin V i
Ma. | Caption Date | Author | Descripkion
1 [Inclusion | 2006-04-23 16:13:35 John Mon-rekal inchision in
Z | Tissue | 2006-04-2Z 13:01:25 Jack | The haze illustrates spherical aberration. It cannot be
3 Bone | 2006-04-22 16:35:42  Jack Radiograph processed as pho
£ B
Store

Push to save the active image and its measurement result to the
built-in database.

f = =1

Database

Caption Add
Allaw-10000

[ ate
2007- 2- 1 ]

Avthar
Jack

Dezcription

The material to be used in Micrometrics camera housing

Caption Specify a caption for the record
to create. Must be a single line
Alloy-100Cks of text. The title of the active

image is initially displayed but
it is free to specify a different
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one. The caption should be
unique within the database.
Otherwise a warning message
appears as shown below.
Answer Yes to replace the
existing record with the same
caption. Answer No to abort
the storing operation.

P

H_../ Database already conkains a record capkioned ‘Alloy-1000% ', Would vou like to replace the record 7

| ves ||

o |

Drate
2007- 2- 1 Rl

Specify the date of creation of
the record. The date initially
shown is that of the computer.
Click to pick up another date as
illustrated below.

-~

Database

Caption
Alloy-1 000

Date
22 122007

< | February, 2007

1]
4 5 B 7 8
1112 13 14 15
18 13 20 21 22
5 2% 27 28

[ |Today: 24172007

«f

A date may also be entered
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directly.

Ay ithor Specify the name of the person
who is responsible for the

Jack acquisition, processing or
measurement of the active
image. Must be a single line of
text.

Description Specify a single line of text as a

: L note, remark or comment.
The matenal to be used in Micromet

Push to add the new record to
Add database.

-

Push to exit the dialog and do
not modify the database.

Load

Push to open the selected record in the database.
Note a record in the database must have been selected for this

command to work. Otherwise a warning message appears as the
following.

! "_-. Flease select a record |
[

When a record is successfully loaded, a new image window will be
created to hold the image data from that record. If the image has been
measured before, measurement information will also be loaded into
the auxiliary window Measurement.

Delete

Push * to delete the selected records in the database.
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Note for this command to work, at least one record has to be selected.
Otherwise, the following warning message will appear.

' E Flease select a record |
[ ]

A deleted record cannot be restored.
Refresh

Push k| to reset the record list to its default state.

Upon startup, the auxiliary window Database shows the most recently
added records, up to 100 entries. After a query has been made on the
database, the auxiliary window Database shows the resulted record
list. Choose Refresh to list the records in the order of their creation.

Query

|
Push “to search for particular records in the database. Before the
search, criteria of search have to be established.

Query by Date

Click Search in ¥ and select “Date”. The toolbar of the

auxiliary window Database shows the two date control
21 112007 5 2 112007 %
LA = FAf * where the time interval during
which the search will be done may be specified. Use the spin buttons

|
to adjust starting and ending date. Push "= to start searching. The
search result will be given in the record list.
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Query by Author

Click Search in ¥ and select “Author”. The toolbar of

the auxiliary window Database shows the edit control

John where the name of the author on which the

|
search will be done may be specified. Push “* to start searching. The
search result will be given in the record list.

Query by Description

Click SN ¥ and select “Description”. The

toolbar of the auxiliary window Database shows the edit control

inclusion )
where one or more words on which the search

|
will be done may be specified. Push " to start searching. The search
result will be given in the record list.

Histogram and Look-up Table (LUT)

Histogram u

.S LT
lUl_ L I_l_.-'
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A histogram is a graphic representation of the number of pixels at
each brightness level in an image. Optika Vision Pro plots histograms
for all three channels of the active image based on RGB color model.
In the black square box, the x axis represents the color value from
darkest (0) at the far left to brightest (255) at the far right; the y axis
represents the frequency, i.e. the total number of pixels with that
value; the origin of the histogram is the bottom left corner of the
black box. Note that histograms of red, green and blue channels are
shown in the same coordination system as red, green and blue bars
and so they may overlap. The following table helps to tell the
overlapping range of the histograms.

Red and Green

- Red and Blue

Green and Blue

Red and Green and Blue

The histogram can be shown for both still and live images. For a still
image, its histogram is updated whenever the image itself is being
modified in any way, including the way it is being displayed. For a
live image, its histogram is updated in every three seconds. In both
cases, the histogram is only for the part of the active image that is
visible on computer screen.

Superimposed on the histogram is a look-up table (LUT) which may
be applied to incoming images from the camera. The LUT is
specified by two controlling points, namely the left point (x1, y1) and
the right point (x2, y2). The two controlling points, together with two
end points (0, 0) and (1, 1), defines three connected line segments
that map the dynamic range of the camera to 8 bits. LUT may be
turned on or off, reset, or specified by directly entering coordinates of
controlling points, using the toolbar button at the top of the histogram
window.
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LUT is most useful to imaging with X90 cameras to exploit the large
dynamic range of these cameras. The latitude, or dynamic range, of
an X90 camera is 16 times that of an X18 or X16 camera, which is
the standard 8-bit camera. Regardless the dynamic range of the
camera, the computer screen can at best display 8-bit image.
However, if we map only the lowest 1/16 portion of an X90 camera’s
dynamic range we will see very dark features and will not lose any
details which the computer screen is capable of displaying. The LUT
is designed exactly for this purpose. A LUT is defined by two
controlling points. The three connected line segments, as made up by
the two controlling points and two end points, specify how the
dynamic range of the camera to that of the digital image. Needless to
say, LUT is able to do much more than showing dark features. In fact,
a general purpose LUT, as is provided in Optika Vision Pro, is used
to enhance pixels within a particular intensity range and this intensity
range is not necessarily limited to 8-bit. A schematic plot of LUT is
given below.

1 Lo m o !
y2 ........................... ; :

z !
@D ! |
s ! i
o f !
< ! '
> ! |
QD ; .
3, i :
(] i ;
5 ! i
5 ! !
(@) ! |
D i ;
yl i . |

(0, 0) x1 X2 1

Original Dynamic Range

Setting both (x1, y1) and (x2, y2) to either (0, 0) or (1, 1) effectively
cancels the intensity windowing. It is required that x2-x1>0.01.

LUT may be defined by entering the coordinates of the two
controlling points. To do this, select File -> LUT -> Define and fill
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the popup dialog box. LUT may also be adjusted in a WYSIWYG
manner in the “Histogram” window. Press down the left mouse
button at a position to the left of the left controlling point and drag to
adjust the left controlling point. Press down the left mouse button at a
position to the right of the right controlling point and drag to adjust
the right controlling point. Press down the left mouse button at a
position between the two controlling points and drag to adjust the two
controlling points simultaneously.

Apply

LUT,
b

Toggle on or off LUT on the camera.

Reset

-
--I-

Set LUT to its default state.

Define
llfl___.

Display the following dialog box where the coordinates of the
controlling points may be entered directly.

LUT for Camera
w1 0141 [0.1] «2 0622 [01] =2%1:01 & 0K
vl 0425 [01]  y2 0905 [0]] % Cancel
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